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Computer Fundamental
PRI BUSTHTH

1.1 Introduction of Computer (F<cX & UR=d)

The word computer is derived from the word compute, which means calculation. Therefore, in
colloquial language it is considered as a calculating device that can do arithmetic and logical
operations with speed, but today its definition has changed

because now the use of computer is not limited to calculation,

today it is used for music, graphics, Internet is also happening in

many other areas. So now we can say that it is an electronic

device that accepts data, and after a wide step-by-step

processing it changes into information and presents the output

result. It accepts stores and manipulates data according to our

need.

FRER Y@ Pl IR HFYC R W s & RTAdT f ¥ AUMT GRAT| I St B W H TH Uh
DAGACT fSaTgd A ST & Sl JffAfedhel 3R AlfSTdhel AU B Aol & AT PR qhdl & IR 3T
@ aRMTYT &1 95 T © i o1 HFYER BT START A% T a9 W T8 21 IS 39T ST
RIfSTh, TTMhad, Sex-Ic NS Py 1 & 4 A1 81 I8 © | A 3@ B HE Idd © (&b I§ Udb Sclaglid
SaTs% & Sl SIeT Bl YR PRall &, 3R U [axgd I—ds—wy URIRAT & a1e S b ¥ gaerdl &
3R arSeye Rofee U &_al & | I8 BN AaIHAl & AR Sl B TAE, TR 3R I Hgele
FRAT B |

1.1.1 Types of Computer (FIR & YHR)

Computer has been categorized in the following parts wise ...

R P frafaRaa Wit § wffea faar mr 3-

=  Analog Computer: Analog Computers are used mostly in Medical Sciences. This very kind of
computers work on continuous data values, for e.g. if you have to calculate the pressure or
something similar then kind of technology having will be useful.
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TATART HFYER : TGN HRYSR BT SUAN SATGIR fafdbedr fasm # fdar Srar €1 39 ave &
FrYex RO ST IS R PM K &, SaERY & ol AR TuP! Ta1d T HB A A8 BT T0AT
BRAT 8 I §9 UBR DI Abeiich BT &I SUART BT |

Digital Computer: Digital Computers are the most commonly used computer on a digital
technique which is widely used and preferred now-a-days. This kind of computers uses micro
processor technology which is quite digital and able to calculate and execute million of
instruction within a second. This also comes under kind of categories as we can see
downwards.

fforea Traex : fSRca TR T RSfica a@-ie W Fa9 iffes WA i S arell HRex
2 Sl 3oidhel @9d 9 W SUANT fhar oar & iR uxig fhar Sdr 81 s9 ORE © AIgshl UIRINR
dh-Ih BT SUANT BRI & ol fSTed & 3R e Adbs H @l @l &1 T iR fharaee &= §
T 21 5 W IR Aot | dfer ar @ S fAefafaa 8-

# Micro Computer : The processor is very small so that called Micro processor and device is

called Micro Computer. Micro Computer is single user device example: Desktop, Laptop,
Palmtop, Notebook, PDA etc.

HAIZH! HYR : AR 98 BICT 89 & RO ASHI YW R fSI8H BT ASHT H¥YeR Hal
SIAT & | ATghl HFger RTa Yok f&arsd &1 IIERU &— SWhe, e, UHeiy, Aeqgs,
dreiy, s |

+ Mini Computer : The processor of Mini Computer is small but larger than Micro

processor. Mini Computer is multi user device generally used in designing company for
commercial use.

Ol Fragex @ i PR o1 GR BITT feg ATSHT R ¥ 997 811 € | A SR Aol
Ior fEarsd & 9 dR R aAaaiys SuanT & fory feomefiT o # SuarT fear srar
=l

*+ Mainframe : It has larger processor and multiuser device. Number of users is more than
Mini Computer. This is multiuser and multitasking device mostly used in Metrology.

AHH : 3AH 9T URIR 3R AIgoR f¥arsd BT 1 go @) Wn A deR | SaneT
BT 2| I AR 3R ACICIRGT Sy &, e SudNT SATeIaR Aglaion # fhar Smar & |

+ Super Computer : The processor is biggest than other Computer and processing capacity
is highest than other devices. It is Multi user fastest calculating device, generally used in
nuclear science for calculation purpose. CRAY-I is the first Super Computer. India’s First
Super Computer is PARAM-10000.

YR FFYER : YR 3 HRYSR B ol § a9 TT © iR YRR ervar o fsarsar &
JT H W A T | I§ AeCIgoR, FIW ol TAUET B Il A B, e ST IR
TR OET & IqaT B fory forer A # fHAr S 81 CRAY-I Ugell R HFIeR © | MRd
BT gl GuR HFek PARAM-10000 2 |

= Hybrid Computer : The kind of computer comes with both characteristics (digital and
analog) are called hybrid. This is used there where it needs to calculate both the digital and
analog data for e.g. In Hospitals.
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BIEMAS HYER © ISR BT ISR i faRwamei ([$fed ok vardi) & @Ay ofnar &, O gfds
HET ST 8| $HGT SYART a8l fhar Sar 8 o8t fesiicd iR UAeiT ST S0 &1 0T B &Y
JAITIRHAT BN 2, O IRUATA H |

1.1.2 Characteristics of Computers (F¥geX @1 fa¥ivar)

Speed : computer can perform any types of work with greater speed. It takes only few
seconds for calculations that we take hours to complete.

e : FYR AP s & AT fFA | UBR BT SR IR FHAT © | I8 B T0ET BT Fdbs A A
B I H DR bl 8, STdih S ITUHT Bl Th AR Hel § T8l B UrRe |

Accuracy : Computers can do the calculations without errors and very accurately. A computer
fault can occur only if the person has given incorrect input or instructions.

YEAT : FYSR 91 B Tl {6y g T0EN FAE—TET PR Fhl & | DS H Bl Tl T
AHA & 919 Afh gRT Tad gge a1 e iy v 8|

Diligence : The computer can perform any task continuously without getting tired.

&I @ Fger ) ft B &1 997 9@ TR HR AHAT B |

Storage Capacity : Computer has a memory which can stores large amount of data for a long
period of time as well as short period of time.

WSROI &FAT : HYSX H TP HARI BT 2 ST g1 A1 H STl Bl ofdl @iy & Ar—dF $H 99 &
forg ff R W |@Hd 7|

Versatility : Computers can perform multiple different tasks at the same time for e.g. Playing
music and drafting your document and even you can print a page.

THEASY : FYER UH & THI H BT AT BRI B Fhd & | IEERT b oy TRIE = He
3R T SlAHE PI WK HIAT AR T8I TP [h Y T g Y fiie &R e € |

1.1.3 How to Start Up a Computer(#+gex I o8 WIS )

Here we will see and learn starting a computer system in some simple steps as follows...

Connect the cables: Connect the power cable with the power socket at the rear panel of the
computer system to supply power to the computer to get start. The Basic peripheral devices
required to work on a computer must be connected with their ports like Mouse, Keyboard and
Monitor etc.

Supply the Power
Supply the Power/Electricity to the computer system connected to an electricity board through an

UPS.
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Press Power button
This is the switch button which does start the computer after being pressed.
Wait for the computer to boot up

A screen showing a logo "Starting Windows" will appear - this is the initial 'boot up' screen.
After the booting process, one screen will appear which is known as Desktop. Now you can perform
any types of work like creating any folder or open any application or file on a computer.

T AT & 918, U WA s 3l 59 SWpeiu & wU § T ST © | 39 Y HRgeR W BT Y
TNE BT BH B b 8 ol Pl Blesy g9 AT PIs TeIBIT AT HIsel Wil e |

1.1.4 Basic Applications of Computer (&R & IR® TRADH)

Computer is very useful in our day to day working. The basic applications of computer are:

PSR AR Sf TP SfaT H 957 SWINM 2, FYR & IR Tl Frfefad 2 —

e Word Processing : Word Processing software help us to do our day to day work smoothly like
letter typing, making resume etc., it automatically corrects spelling and grammar mistakes.
TS WRIRT : I MR AifeRR &4 oo T WR & Bl B gars w9 B § 7SS SR § o
diex ersftin, Reym a4 onfe, g wanferd wu 9 Wi iR & @t Tafadl &1 e axal & |

¢ In banking : Now-a-days Net Banking is become popular. Most of the people do their banking
work by using Net Banking.

BT # : gduT gHw F G BT AR B W 2| A BT BT SuAT R AT Afed oA
dfpT B B 2|

e Internet: You can connect your computer to any computer anywhere either in India or abroad.
It is a global system to interconnected computer network. You can browse through much more
information from Internet than you could do in a library.

ST : IUCC B WRIH W MY 37U HFYSR Pl ARG Il e & R o drger & A1 oie

Ao 2| U8 FFYEX edd B ITH H Sied @l Uh afkgs yomelt (global system) @ | gvewie &
qed W 3T TS BT SUeTT i SR U hR Hehal ¢ |

e Hospitals : In hospital you will see that the records of patients related to name of patient,
disease diagnosis etc. are stored in computer. By one click doctors knows about patient history.
gifeed @ sifdcd # &g < 6 I/ & M, I Fem anfe ¥ |aftd wWeil & Rele doer 4
TR B B | Us fdads 9 Sfae’l & IR & sfagN & R H uar gerdn 2|

o Digital video or audio composition : Computer makes easy Audio or video composition and
editing any types of audio/video film. You can put special effects in action movies which are
being created using computers.

feofica fafear ar siffsar HIRIM : T & gR1 &4 fodll N weR & SiifeAr a1 difsar @1 Fwr
Td Ufde ax Add 2| M9 VA vaere fhedt # faRiy yMd STl Adhd € O BRER BT SUANT XD IS
ST & 2
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JTRfET Rived

2.1

run other application programs. Task of the operating system are:

ATRFET Rived U Rived AffedTR 8 Ol $Fgey BISaeR 3R AfteasR RS &1
Yo R B IR FFER W & oy AW |ad Ye Rl © | TAE HRex |
I U UM T © U e JiiRfeT Red gidr 21 3iTRET Rreq & &
e g

Introduction to Operating System
(SiToRfET Rieeq o aRaw)

An operating system is system software that manages computer hardware and software resources
and provides general services for computer programs. Every computer has an operating system to

Operating system is the soul of the computer system without that you
can no more imagine to run a computer.

JATRFET Red F7gex Raved &1 e 8 s 391 o vger aem™ &
IR H AP BT ol R Ahd © |

Operating system plays like a role of mediator which interprets the

instructions to Computer hardware made by a user.

JTRFET RIFeH Uah AeIReT @1 @RE BRI BRAT & Sl SUANTHAT §RT G917 Y HRYSR BSR P Aozl
B AT BT R |

An operating system keeps and maintains track of files and directories on the disk, and it does
control the peripheral devices such as Input/Output devices, disk drives or any plug n play
devices.

T ITRET Red fevp W) Bl 3Rk FEReRl &7 6 Waar 8, R I8 Wexd feasis o

$TYe / ATScye fEarsd, 5% $r3d a1 50 @ o =i farsd &1 FrRifFa #=ar 21

2.2

Operating System controls execution of computer programs.

SITORfET RIvew HFger UM & YfRTag@ &1 Fgied Hral ¢ |

Types of Operating System (STRfET Rived & J&R)

Batch Operating System - 39 3ffRféT Rrew - It is used to execute similar types of jobs in
batches automatically.

ZABT SUANT S48 § THE UBR & B B Walferd ©u 9 Fefed = & forw fear Smar 21

Time sharing operating System - =Ed Jaffr SffRfeT fiwed - allows many users to share the
computer resources. (Max utilization of the resources).

IR DI HRIE A YR G B T <al © difs RETAST &1 3ffebad Jfeagorad 8l 9 |
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= Distributed operating System - fSResgcs SifRfe Rieew - Manages a group of different computers
and make appear to be a single computer.

R~ F7geT & YU BT IS BT 2 3R Thdl HFYER YAl 8l & |

= Network operating system - Jca® 3ifRfET s - computers running in different operating
system can participate in common network (It is used for security purpose).

faf=1 IRfET RRed A = dTd FgeR BIFT 7cdd § W of Adhd 2| (SHHT SUINT GRefl
Sqeeg & forg faar Siar 71)

= Real time operating system - R¥al e€7 SiTRfET Resd - In this type of system, processing must
be done inside the specified constraints. Otherwise, the system will fail.

39 yaR & Reed #, Afde el & ofer wraRivT fFar sen =nfey | &1 af Rives e 81 SIme |
Examples of Operating System are (IiTRfET Ried & IR B)

2.3

2.3.1

Windows (GUI based, PC-->Windows 10, Windows 8, Windows 7, Windows Vista, and
Windows XP),)

Linux-> Linux is absolutely free and will literally run on anything.
(Ubuntu,Fedora,LinuxMint, openSUSE, PCLinuxOS, Debian, Mandriva,
Sabayon/Gentoo, Arch Linux...plus Slackware,Puppy Linux...plus DSL)

macOS (Macintosh), used for Apple’s personal computers and work stations (MacBook,
iMac).

Android (Google’s Operating System for smartphones/tablets/smartwatches)
iOS (Apple’s OS for iPhone, iPad and iPod Touch)

Chrome OS: Chrome OS is available on a number of Low cost and some high-end laptops,
like chrome books.

Free BSD: With its roots connected to Linux, it is the modern-day version of the Berkeley
Software Distribution.

Syllable: Syllable is yet another free alternative for home and small business users only.

ReactOS: Initially launched as a Windows 95 clone, this OS has come a long way since then.

Operating Systems for Desktop and Laptop
(Spe IR dueiy @& fog sifwfET Riew)
MS DOS (TaTs F)

DOS (Disk Operating System) is an operating system that runs from a hard disk drive. It provides
command user interface. In this type of operating system every tasks are performed by the
commands. And commands are the predefined in the system interpreter that has specific meaning.

DOS (%p IMRfET Rived) T IRET Rived & St 818 3@ F18d 9 FaId1 2| I8 FHAS ok Scibhd
US HNal B 39 UBR B MRET Red ¥ yde ol waie g fhal oeam 21 iR odie Red
sexfier ¥ gdfeiRa 8 & e faftee el g & |

2.3.2

Windows Operating System (fd<isr sifarfeT Rie#)

This is the most popular operating system of a graphical user interface. It is also a multi-tasking,
network-supported operating system. There are many versions of Windows that have separate
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operating systems for both server and stand alone. This supports TCP/IP protocol. It performs
memory management with files, folder/directory management as well. There have been many
versions of Windows but only here we will study about Windows 10.

IE UP ITfhbel Yok FTIBWE T GaH Thg JATRET Ried 21 I8 W Acl Siff® T, Acas auics
ITRET Red 1 fI=IoT & &3 o9 I 8, Wk 1 evs Tl aFl © 1T 3rerT offfeT Rred 21
g ML /MW, Wbl BT FUC BRAl 2| I8 BISd, Blesy /SRRTE] A-oiie & A1 & 4RI
HoTTe Rl © | fa=sSIeT @& &8 a9l I § W= I8 WR % Windows 10 & IR ¥ &1 I &l |

2.3.3 Linux Operating System (foma¥ SifRfET Rive#)

Linux is popular operating system for PC users around the world. It is an independent Portable
Operating System Interface (POSI) implementation.
Linux does true multitasking and includes virtual
memory, shared libraries, demand loading, memory
management, TCP/IP networking and other features
that are available with current full featured commercial
operating systems. This operating system was initially
created by Linus Torvalds, in 1991. In 1994 the first version of Linux Kernel was released on
Internet. Linux is an example of Open Source Code Operating System. It has nearby all the features
present in Unix Operating System.

forad g R & 90 SwarTediRll @ oy e SifaefeT RRed 21 98 ta w[@ad dicad SifmfeT
Red gexwd (POSI) @1 dRE i &xarl 2 | foiad # arafded AccieIReT B8Rl & 3R 99 dgard 4[N,
TS AssNI], fears ST, 7 feortie, SR /3msdl [edfe T 3R o ®ieRd el 31 & S o
Hd gul faRiamsil ardl FaRie iRy Red & o Iuaer 2| I8 SifuefeT Red gwernd # 1991 #
TS Cldiegd §RT ST AT 7| 1994 # foa &vicl &1 USAT HHRUT $ex-e R SIRI fdear Tam o |
forTa™T 3= | Ple IR RiRed &1 IITERT 2 | 398 I AT Rwed # HAigg 941 faRivang & |

2.3.3.1 Feature of Linux operating system (forae SifarfeT Rived & ®IeR)

= Multiuser capability : Multiple users can access the same system resources like memory, hard
disk, etc. But they have to use different terminals to operate.

TESWIRTHAT & © 3% STANTHAT U & RIRed A9rE! S 79N, 818 3@ anfe &1 STnT &~
Thd B, ifh I Farferd o & v faf= <faal &1 STIRT &A1 gsdr 2 |

= Multitasking : More than one function can be performed simultaneously by dividing the CPU time
intelligently.

ARICRST : A & I BT 9 A g - o | 1fe 11 U A fby o aad § |

= Portability : Portability doesn't mean it is smaller in file size or can be carried in pen drives or
memory cards. It means that it support different types of hardware.

AR : UIERfeTEr o1 Aders a8 & 8 fF I8 B eR # Bier & a1 30 U9 SR A7 TR bre §
o SR ST Ahal 2 | 39T Adeid & b I8 a1 yoR & SSdaR &1 JuIie &ar 2

= Security : It provides security in three ways namely authenticating (by assigning password and
login ID), authorization (by assigning permission to read, write and execute) and encryption
(converts file into an unreadable format).
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&I : UE A DI W GRET UG BRAT & i Siffeafe (ras iR difi sl MsT ava),
RSO (FgH, ot SR gfaage &’ @1 oigAfd ua axa) iR UfheM (FIsd &1 U@ smfed
yreu 7 aRakia &x®) |

= Graphical User Interface (X Window system) : Linux is command line based OS but it can be
converted to GUI based by installing packages.

Thee Jor scvnd (Yo fier fawen) @ foraw @dls orss omTRd e § oifde sad Uasll &
gCTd B oiigerE # aRafid fhar S Faar 7|

= Application support: It has its own software repository from where users can download and
install many applications.

TRABIE FUIS: 9P U 0T GFedqR WIS & ogl 9 SUANTHdl 3P UaTdh Sre-elis 3N gl
P FhT 2 |

= File System: Provides hierarchical file system in which files and directories are arranged.
Bigel RIEEH : USIIHHT Bisdd RIRed U &_al & ORTH Bigel iR SFNTE] FafRerd el & |

=  Open Source: Linux code is freely available to all and is a community based development project.

I A o dls ¥ & oy wada w0 ¥ U © SR U G TR e alRare T § |

2.3.3.2 Key Differences between Linux and Windows Operating System
(foraw 3R fdSIe SifmRfeT Rivew & 99 = 3iMR)

1. Linuxis free and open source operating system whereas Windows is a commercial operating
system.

oy guT 3R 3l A1 SifRfET Rived & Siafd A ua i sifmfeT Riweq & |

2.  Linux provides high security than windows because Linux is open source.

fora fISIaT @1 o 3§ S GReM Ue HRal & Hifds fomadd 3o |9 2 |

3. Windows must boot from the primary partition. In contrast, there is no such constraint in
Linux it can be booted from either primary or logical partition.

IS @1 warfie v | g &R BN gae wda, forad # Ui @18 awn w8 2 59 mafis
1 Aifdes Ao | g fhar S Addr 2 |

4. The separation of the directories is done using a backslash in windows. On the contrary, in
Linux, these are separated by using forward slash.

SRNGERIS] Bl fdSieT #§ Shwisl &l STINT o 31T fhar orar 21 s9a Qg oy 8 s
BIGE I BT SYART HRP T fhaT el B |

5. In Microsoft Windows, files are stored in folders on different data drives like C: D: E: .But,
Unix/Linux uses a tree like a hierarchical file system.

Arsrrde fiere # wisel =1 Ser gea o - 3 € R @ Wl € JfdE, gt /fora T
I Ad Wisel RIReH S €1 &1 SUANT &xal © |

6. In Microsoft windows Administrator user has all administrative privileges of computers. But
In Linux Root user is the super user and has all administrative privileges.

ArghNTe ISl 3 TS gey ok & N $ReR & 9 Teatie fRmiRer €| afes fome
wC YR F W YoR ¢ 3R 399 9 wemafie fRwfier € |
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3.0 Introduction to Word Processing

(a2 IR @ uReEr)

Microsoft Word is a word processing application that allows you to create a variety of documents,
including letters, resumes, paragraph composing and more. Microsoft word is a tool of Microsoft
Office suite which has a large number of earlier and latest versions. Here we will discuss about only
Microsoft Word 2010, 2013, 2016 and 2019 versions.

AGHIATE IS Th g R URAdhed & S omudl ud, Regy, IRums i onfe afzd &s dRe &
STRAT M @I A <dT & | AlghIae dae Ashge Afhd ge &1 Ud ¢ & forad del | #
Ugal 3R 3T & U Ioid U © | T8l 8H bdol AISHNIGC TS 2010, 2013, 2016 3IR 2019 & oAl & IR
# =t BT

Microsoft office word 2019 is the latest version of Microsoft Office suite package for windows and
Mac where this overcomes over all the previous versions launched earlier. It was released to
general availability for Windows 10 and for macOS on September 24, 2018. MS Office 2019 is a used
to create, edit, save and print the document like earlier version of office.

AIEHIEITE TS 2019 HAISHINTGC NHH Y # I8 & FId Td=ad doiq & ol e @it asi= @ gfaay
arofl 2| AgeTde b 2019, 24 RideR, 2018 &1 Windows 10 3R mac0S & foTv A= Sucierdr &
forg S forar Tam o | WG AfhE 2019 & SUANT SfRpTT 99F, YT A, AT HIA SR fie
H @ fog fFar Sar g o 6 onfd & gd aoi= § grar o |

We can also perform same work on Microsoft word 2019, as we performed on Microsoft word 2010,
2013 and 2016. There may be some slight differences, but for the most part these versions are
similar.

T ASHNITE I8 2019 TR 4 981 B B Adhd 8, ST 899 ASHhINTe s 2010,2013,2016 WX fdhar o |
O AR AR B A 8, Afb AfAHI 9T B forg A aoi a9 B

3.1 Opening MS Word Processing Package
(TQE IS YRR 96 BT U $H=AN)

Starting Microsoft word 2010, 2013, 2016 and 2019 etc are very easy like its earlier
version. You have to click on the start button, select All Programs, select Microsoft
Office, and then select Microsoft Word 2010/2013/2016/2019. For quick access you
have to do double click on Microsoft word icon available on your desktop.

ASPIAMS TS 2010, 2013, 2016 3R 2019 3MMfA I Y& BRAT $HD YR doid Pl 8 dgd 8 AR 2 |
JMYP! LI ged W fderd P31 81l 8, bR All Programs &1 Helde &<, g8l Asshge Alfhd gd 3R
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iR ATSHIGE € 2010,/2013 /2016 /2019 TR facid &N 3R TRA 9 I I & ol MMUD! UH SIH(U
R I ATSHINATE TS MSHT W I fdeld HRAT 81T |

3.2. Elements of Ms Word window (THg¥ ds fa=el & uferd<d)

1.  Title Bar (S¥ca aR) - This bar appears at the top of the document & displays name of the file
as well as minimize, restore, maximize and close buttons are available at the right side of this
bar for controlling the window.

T8 IR SfegaT & W R R a1 2 iR wea & 9@ uelRfd wrar 7 sk w1 & faser &
i3 o @ oY o9 IR @ <18 iR AFEEs, ReRr, Jf|iger 3N delol 9+ SUerel 8idT 2 |

2. Ribbon and Tab (Re= &k 29) - Microsoft Office displays commands in a series of icons stored
on different tabs. This combination of icons and tabs is known as the Ribbon interface. Each tab
contains several groups of related commands. For example, the Font group on the Home tab
contains commands for formatting text in your document.

Microsoft Office fAfa= 9 R HULIT 3MgHT & U VRS H HHIS U3 Bl © | AMsh IR d
F 39 A BRI $eXBF & ®U H AT ST 2| IAS <d H HERd BHS B PHs YU B T |
IR B oY, B9 29 W Bie U H MU SagiT H SRS BT BiHT B B oY BHIS BT B |

The following tables show the commands grouped under each ribbon tab for Word Application.
771 2fdd Word tfedem o forg e Rew 29 @ i wiea ais & R §|

Ribbon Tab Name Command Groups

Home Clipboard, Font(Ctrl+D), Paragraph, Styles (Alt+Ctrl+Shift+S (Styles)), and
Editing

Insert Pages, Tables, Illustrations, Apps, Media, Links, Header & Footer, Text, and
Symbols

Design Document Formatting and Page Background

PageLayout/Layout Page Setup, Paragraph, and Arrange
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References Table of Contents, Footnotes, Citation & Bibliography, Captions, Index, and
Table of Authorities

Mailings Create, Start Mail Merge, Write & Insert Fields, Preview Results, and Finish

Review Proofing, Language, Comments, Tracking, Changes, Compare, and Protect

View Views, Show, Zoom, Window, and Macros

3. Quick AccessToolbar (Se9R) - The collection of buttons (usually with icons) that provide

shortcuts to tasks; typically located at the top of the screen. By default, it shows the Save, Undo,
and Redo commands, but you can add other commands depending on your needs.

e BT FUE QAR R MSHA & 1) ST Braf B Iledhe YaH HRal 2 | AR R whiT & oy
R Rerd BT B

Ruler (¥eR) - Rular at the top (Horizontal) and Left side (Vertical) of the page that shows the
margin, Indent and tab settings (on the horizontal ruler). Indent is used for word wrapping
setting. If you want, you can also hide the Ruler to create more screen space from view tab.

BR US B FW (@Roed) iR a1€ 3R (@fdepe) fRwE <ar & o @ifv, €se ok 29 ufew &1
fegrar 21 s9e as MUT AT & v ST fhar Sar 21 afe sy @rE), Y W W Sarel W
T & oIy ek BT F <9 9 o Blss W B A o |

Status Bar (¥¢e¥ 9R) - This bar appears at the bottom of the screen that shows information
about the page, section, line, and location of the insertion point. Information about Macro
recording (REC), Track Change (TRK), Extended Selection (EXT), Over Typing (OVR), and
word count etc. also shows on this bar.

TE IR BHIF B rgel 9rT # @ a1 @ O U TR, 9, AR 9% iR R B W B IR H
SHERT fa@mar €1 A1 RS @mRSH), 2o o (ERRe), Taacss FoddeM (Syae), iar ergfi
(FRIR), &R 98 ®Se fe & IR # W ITFeR) 39 IR # fawE <t 21

Backstage view (§®%%dl &) - Backstage view gives you various options for saving, opening a
file, printing, and sharing your document. To access Backstage view, click the File tab on the
Ribbon.

famed I B | TP I BT TR B b oy, ReT R BIsat 9 R fadtd ¥ |

3.3 Basic Ms Word Commands (3% 7909 98 $97E)
3.3.1 Creatinga New Document (71 Sfagic e &)

As you know that each and every document in MS word is based on template,
whether it is a blank document or based on predefined templets. Predefined
templates means the templates designed according to the basic requiremet
of the document, as if you want to write a simple letter or business letter,

you will find some basic contains as Letter number, Date, To, From on template.

ST % 3y oid € f6 MS Word # 9% STRfic <rieie R MRd B, 918 98 U <id Siagic & aT
gafEiRa <Hrele 81| qaMgiRa <Heled &1 Aded & b Sfagie & qd awgdhdl & Jgar (Suis fby
Y SHeIE, SN b 3T U |RIRYT U3 AT TEdTad 97 o= dred g, AP $8 garal R i ek
R, faAid, T onfa I 99 SHele R Ugd ¥ el |
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If you are working with a word document, you can create a new blank document with opening the
word program by using the following steps:

I MY Uh IS SIS D WA BM IR B ©, Al MU FEARIT LU BT SRR BRb Uh AT <lD
SfREE 91 Ahdl o

1. After open the MsWord 2010/2013/2016/2019 Application, Select the FILE tab to access
Backstage view

2. Select New, then click Blank document.

3. A new blank document will appear on your screen.

You can create also online various templates by using the above steps on Microsoft web-site.

THUE TS 2010 /2013 /2016 /2019 UADHEH 3MUF R4 & 918, davcsl & R OF & oy, B cd Bl
Aolae o | -8 A § New fIded & Helde o iR <id Sfagiic R fadd o | s Bhid R Tdh
T < Sagdc feE@d T MY Microsoft d9—W1gc TR SURRD aRON & SUANT &xd A= oifFerge
Tele W 94 bl ¥ |

In Microsoft Word, a document can be easily created. After the opening of the document, a cursor
blinks in the document area, which is often located on the left side. From here, we can type text in
the document and type it and press spacebar to provide space between word and Backspace is used
to remove a character from the left side.

Microsoft Word # &g ¥ SfREHC A & a91-01 ST A1 & | i & G & a8, Siagic ad i
T B fodid HRar 8, Sl 3R 918 IR Rerd 811 2| J8f 9, 89 SiRgic # THRe TRY IR Wahd © 3R
It & T H W T B oI WHEIR U9 AR 2| IR I TR%G B PhRaes B gSM B oIy 9% W Bl
SRS fehar ST 2 |

3.3.2 Opening an existing document (FSET SEFC DI AT H)

You can open existing file or created earlier file by using following steps :

f=ferRad oo &1 YT BR 3MY Ul I I Bl T3 BIsel bl U DR Fhd o |

e After open the MsWord 2019
Application, Select the FILE tab
to access Backstage view

e select the open option from
drop-down menu then

e You will find various option as
Recent document, One Drive,
Computer and Add a place

e C(lick on computer and locate
the document file and Click on
Open.

e Now the existing or used earlier file will be opened, you can read or manipulate.

AT R I B TR AMUBT ATV STIANT 19T faRIT T8t MY BIisdd BT AlDI Ud BIsdd bl aI-T DY
B AP AT B Thd & | BIsdd <8 /b ged R foaad & | 39 3T R e B |
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4.0 Introduction (aR=)

Excel is a spreadsheet application developed and published by Microsoft. It is part of the Microsoft
Office suite of productivity software. It allows you to store, organize, and analyze information. Excel
organizes data in columns and rows. Rows and columns

intersect at a space called a cell. Each cell can contain a

single of data, such as text, a numerical value, or a formula.

Microsoft Excel was not the first spreadsheet program,

Lotus 1-2-3 and VisiCalc were popular spreadsheet

programs released before Excel.

TR ATehNTe gRT fAaRid 3R ufeetsr T Wedie tfaeH 21 I8 SACHhdl JicdiR & HghNTe
3ifthe e @1 BT B | IT ISP AN BT YLK, FIR AR fIeelwo o= 1 sgufd <1 2| gad
STl BT DI 3R A H JaRYT HRal & RT MR Bl T AH R gredde dRd & (o Jdf $el il 2 |
A% A H U6 UHd Sel & 9adl 8, o RS, Uh RIS ded, A1 Udh BRIl | AISHIATe Tavd Igdl
Bredfic UM T8t o, e 1—2-3 3R VisiCalc, ATsHNTe Taid ¥ U8l OIN by U Aaig Jrsdie
I o |

Microsoft Excel 2010/2013/2016/2019

Excel 2019 is the latest version yet in Microsoft Office 2019 package. All the version of Excel may be
some slight differences, but for the most part these versions are similar. In Excel
2010/2013/2016/2019 version, the operational and functional commands are situated in tabs which
that let the user to perform tasks on the Spreadsheet. It is displayed in Gridlines means its working
area is the collection of Rows & Columns and that is formally known as Sheet. Microsoft Excel
2010/2013/2016/2019 contains tabs of different kinds like Home, Insert, Page Layout, Formulas,
Data, Review and view. In Ms excel, column value is identified by the column header which is label as
ABC,....,AA,....XFD. But Row value is identified by the row header which is label as
1,2,3,..10,48,576.

Excel 2019 Microsoft Office 2019 Yabsl # 31 T T FdIFTH TP 8 | THRIA & |4l ol H B Al
3[R B FHdT B, ol ARG 91T & fofv 3 goi9 9+ 2| ATShIarge Uaid 2010 /2013 /2016 /2019 &
qor # 3iRIA iR Baere dArs ¢d # Rerd & & e IR goR |Iedic # 96 WReH axdl 7| I8
freamss # foars a1 @ SHdT Haad 39 i URAT A & Sl 3 3R DIl BT bl & AR U AMAR
WR ¥ic & ®U H ST O] B | AISHNIGE Uasid 2010 /2013 /2016 /2019 # B1F, $IC, US <laTSe, B,
Sel, R &R & o fafi= goR @ <9 WfAd B & | TATH. Taid H dicH 9oy B BiaF g% 8N
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g Ol & O f6 ¢ 1, W, L UU . TaIUwel & wU H o d B | dfhd I Iog B A TR NI ggAET
SITAT § ST 1,2,3, ... 10,48,576 & ©U H oidel & |

4.1 Opening MS Excel 2013 Package
(THTH TS 2013 YBoT BT 3T B

To open MS Excel on your computer, follow the steps given below:

Method 1 : Click on Start -->Select
All programs->Microsoft office
2013-->Microsoft Excel 2013

Method 2: Alternatively, you can
also click on the Start button and
type Microsoft office Excel 2013 in
the search option available.

After open the Ms Excel, If you
don't want to use any of the
templates on display, click on the
Blank Work Book.

A new blank Spreadsheet will open up ready for you to start.

4.2 Elements of Spread Sheet (JIsfic & tferi<)

¢ Ribbon:The Ribbon contains multiple tabs, each with several groups of commands. You will use
these tabs to perform the most common tasks in Excel. Each tab will have one or more groups.
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Rea— Re # &8 29 80 € R 9 ud% 4 s & &3 YU B 2| Tadd § 999 A SR e
® oY o0 39 <9 BT IWINT T | IAH <9 H U AT Af¥d a8 |

e  Worksheet: A Worksheet is the place where the user works and performs arithmetical and
functional calculations. By default it is named as Sheetl, Sheet2, Sheet3 etc., a sheet can be
renamed too.

TP YIC-aahefic 98 WF 2 S8l YR d& HxAl & AR JIHAPRT 3R Hrafctds T dxar 2 |

f¥wice wu ¥ 30 e 1, 3fic 2, e 3 afe & wu & A0d fhar Sar 8, e &1 9™ Y g5 o
Hepell § |

e  Workbook: A Workbook is the collection of worksheets where the user works.

THgH-UP dHgDd bs IHYUICH BT HeldRd BRil & olel JoRk a9 =l o |

e Cell: A Cell is the intersection of Row and Column. For example, Cell A1 is the intersection of
column A and Row 1. A cell in which mouse pointer is available that cell is known as Active
cell; cells may contain text, numbers and formulas.

JA-UH Aol fHAT U 3R PieH B xR BIaT 2 | Saexv & oY, It Al dfad A 3R Y 1 &7
SRR BT 2| Uh I FTas 9199 Wigex Suclel 8idl & SS9 Jdl &l Ufded 9ol & A9 9 S T
ST 2

e Cell Range:It contains One or more adjacent cells. A range is identified by its first and last
cell address, separated by a colon.
I NS5 TP AT 31 YsoRi< el AR BRll &1 U IS Bl IS Ugel 3R i I & udl
A g Sl 8, O Geb Bl gRT el fdhar Sirer 2 |

e Formula Bar: This bar appears at the right side of the Name box. It displays formula as well
as value entered into the active cell. It is also used to edit formulas and content in it.

BT §R- I8 IR - dfa & qE IR Q@R Iq7 21 I8 Bien & -t Ufded A H T
PIRCT g BT YR BT & | ADT TANT BT 3R Heed BT URee PR H AT Bl © |

e Name Box: This box appears at the left of the formula bar and displays the address of active

cell.
A diag- T8 dfed BT IR @ 978 IR R T € &R wfhy da &1 uar yelRid @war 2

e Sheet Tab: This tab appears at the bottom of the Excel workbook. by using Sheet tab we can

open any worksheet. Each worksheet is identified by label given as Sheetl, Sheet2, Sheet
3...etc. You can rename the sheet name according to your requirement. You move from one
worksheet to another worksheet by using navigation button.
i 2g—u8 <9 TN dagd & frad R # fRar <ar 2 ofie 39 &1 SuarT axa '\ faRl
JHYT B 3T B Ahd 2 | UAd gdheie o oe 1, dfie 2, fie 3. ik & wu # Ry 71v 9a
ERT TSI ST € | 3T 3[U AaeDhal & AR TNe BT A1 dadl Abd © | IR ded Bl
TANT B 3T T e A gk e TR S Aol & |
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Mouse Pointer Styles (A9 @gex ©ged)

The Excel mouse pointer takes on many different appearances as you move around the spreadsheet.
The following table summarizes the most common mouse pointer appearances:

TG AT Brede & IRI AR FAT 2 a1 Tad AISH UlgeR B e —elT wul ¥ fawrs Iar 7| & A9 <9a
H =g Y %

The white plus sign will select a single cell to enter data, retype data or
P delete text from the selected cell. This pointer is also useful for selecting a
range of cells.

s The white arrow will drag the contents of the selected cell to a new location
(drag and drop).

The black plus sign activates the fill handle of the selected cell and will fill
-+ the adjoining cells with some type of series, depending on the type of data
(e.g., a formula or date) is in the beginning cell.

Spreadsheet Navigation (Srediie Afaiem)

The following table provides various methods to navigation around a spreadsheet.

Method Description

mouse pointer | Use the mouse pointer 5P to select a cell.

Use the horizontal and vertical scroll bars to move around the spreadsheet to
scroll bars view columns and rows not currently visible. Click the mouse pointer once
the desired cell is visible.

arrow keys Use the left «, right =, up T, and down | arrows to move accordingly among

cells.
Enter Press the Enter key to move down one cell at a time.
Tab Press the Tab key to move one cell to the right.
Ctrl + Home Moves the cursor to cell Al.
Ctrl + End Moves the cursor to the last cell of used space on the worksheet.

4.3 Creating of SpreadSheet (Fs3fic AR &)

Excel files are called workbooks. Whenever you start
Excel application. You'll need to create a new
workbook. You can choose to create a new workbook
-either with a blank workbook or a predesigned
Template- or open any exisiting workbook.

TRIe BIScll ®I Jdgd el ol ¢ | od A1 370 v
TRADIE IY® B & | AUDT UH 797 qhgdh a1 81T |
AU TH T IHgE B AN B fog, ;AT TE AP

IHYH A1 TH YAMEIRG el I BIS HISET aogd BT
Jolde PR Thd 2 |

4.3.1 By using Blank workbook

e Select the File tab. Backstage view will appear.
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5.1

Introduction (afR=r=)

PowerPoint 2013 is a best presentation program of Microsoft Office and each page of presentation is
called slide. It is used for creating a presentation using template, Creating Animation, Opening
existing presentation slide, Run a Slide Show during presentation, creating

table, insert clip Art, Pictures etc in the presentation.

PowerPoint 2013, Microsoft Office &7 Tdh TISS Yoice WM ® iR Uoices
P UAD UST BT WelsS $al Ol 2| SHHI STANT SRl B ST BB Yol
M, UMHEE 99, HIS[El Uoiced IS Bl W@ield, Yoic| & QR ¥gs o

TA™, < g9, Uoiewd H ey ane, R anfe srom & forw fovan < 21

There are few terms of MS PowerPoint that we will mention and discuss here.
Here they are as follows.

Presentation: The presentation is a collection of several slides that contain information in the
form of text, Audio and video etc on a topic. PowerPoint presentations are commonly used in
business meetings and for training and educational purposes.

YSICI[—TUdh ol s ¥ollgsl BT Uh 9U8 © forad fodll favg R eae, qfifedr ik difear anfe &
7§ AR Bl 2 | UlaRdige Iuieyd MMaR W) S Joh! | 3R ulderr iRk dfee sgwal &
fore SwmT fovar Sirar 2|

Slides: Each page of presentation is called slide in which we can type text by using Placeholders,
insert pictures, charts or other graphics, animate object, add movie and sound and play this,
during presentation Run time.

TAGSH IO & TAD TS Pl FgS P8l ol & foIH 8H widelesy & SWIN IR Cave TIgy
TR WH ©, o3, A A1 3= Wihad AT dR |ahd ©, Slfeiae ®I UFFHT BR 9ad ©, a1 R @
SIe Fhd & 3R 3 USiceM ¥ T8A & IR Idll Fhd & |

Slide Layout: Slide layouts contain formatting, positioning, and placeholder boxes for all of the
content that appears on a slide. Placeholders are the dotted-line containers on slide layouts that
hold such content as titles, body text, tables, charts, SmartArt graphics, pictures, clip art, videos,
and sounds. Slide layouts also contain the colors, fonts, effects, and the background (collectively
known as the theme) of a slide.

WSS AP~ AES RIS # Tlgs W feEs < arel 9l e & forw ®iifeT, Wifve™ @ik
TINEIeSY 91 B © | ©iNElesy WSS oS R Sles—dlgd de-R Bld & o cgfed, drel Tae,
edal, IS, WIcane Ufhed, o, fdera ame, difsar ok wff O e &1 WId 8| Wiss oleise §
TS B W, Wi, ghae IR IGUe~s (Hfed wU 9 of| & w9 # ST ofrar 2) wnfiet €




148// Computer Fundamental & Office Automation

View: You can view your PowerPoint file in a variety of ways, depending on the task at hand.
Some views are helpful when you are creating your presentation, and some are most helpful for
delivering your presentation. Powerpoint has Normal view, Slide Sorter view, Notes Pages view,
Slide Show view, Slide Master View, Handouts Master, Notes Master view etc.

- HA B MR W AT I YRGS WIg Bl A~ TIdl | <@ T & | 96 T 0T IoieeH &1

B E A BB I AR B E, IR HH AMTDT YoicTH < H FIH QT AIGIR B & | UaRUST & I
T &, Flge HieR &, AIed Uolol o, TeISe ARCY &, Aied ARG & 3fe & B 2|

Slide Show: It is the Running stage of the Presentation that displays all the slide with transition
and animation effects according to fixed time interval fixed by a user.

WSS o IT Yoicsd &1 (T o & o SWadl g ad by v FAled w99 sfdviel @ r9R
transition 3IR TR Shacl & AR G WSS Dl Yeid &l ¢ |

Transition: A Transition is the effect that takes place when you advance from one slide to the
next. This feature is available only with Slide Shows.

Sifre: ¢ife a8 shae BT 8 Sl a9 BT § oY AU U ellgs W gudl WS W O &1 I8
G Bt TeTS W B A IJuA 2 |

Animation: In Microsoft PowerPoint, animations are visual effects applied to individual items
such as graphics, titles, or bullet points, rather than to the slide itself.

e AReRNTe dfavdis #, TR fagere shae B0 € O WISe @ ol Il —TelT JMMSeH
SN UTfte, ¥@ A1 gele uige W AR B E |

5.2 Creation of Presentation (Jui=e3™ &1 fA#iM)
Before creating a Presentation you have to know how to open PowerPoint 2013.

USiceM 9™ I Ugl 3BT Ig ST BN b OfdR Ufdls— 2013 & W@ied |

To open Microsoft office Powerpoint 2013

Method1: Open Microsoft PowerPoint by clicking
on the icon on your desktop. Or

Method2: Click on Start button-->All programs--
>Select Microsoft office-->Microsoft office
Powerpoint 2013.

PowerPoint 2013 will open, and you'll see the

Start Screen.

3MMY 3O SEHErY R AMgdH W fFeAd v a7 Start->All Programs->Microsoft office-->Microsoft office
Powerpoint 2013 W f¥i® @d Microsoft PowerPoint &I @iet 3R 3mud! weré whid fearg < |

In Powerpoint 2013, There are two ways to create a presentation
graRaise 2013 #, Yolc¥ M B I WD T

a) By using Template <Heic &I SUINT HRDH

b) By using Blank Presentation @@ USicIM &1 SUANT $HRd
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5.2.1 Creatinga Presentation Using a Template

(T Twele | Ua 41 YSI¥H §11)

Steps 1: Click on the File tab to access Backstage view and then Select New.
Steps 2: Click on suggested search to find templates or search for online templates and themes.

Steps 3: A preview of the template will appear, along with additional information on how the
template can be used.

Steps 4: Click Create to use these selected template. You can also do Double-click Blank
Presentation to create a new presentation.

BlEd ¢ R fadd dN R v New =M | <wele @M & fog fau 77 gsma w s o a
iiellgd Crele ofiF ff WISl Whd €| <Rele &l U Mg fawrg <, fobell off Swyere @l Aelge Y afR
FeldCS SRl &1 SUART & & fory fhue R fdars o | 93 Uoice™ M & foy amu <f® doices ux
Sqci—faerd ff B Fahd £ |

5.2.2 Creating a Blank Presentation (3& &i& Jol¥ &I 94)

Steps 1: Click the File tab to go to Backstage view.
Steps 2: Select New on the left side of the window, then click Blank Presentation. A blank
presentation will appear.

JPES g W GM B oy wisd ¢d R fdde axX| Il & dve |ss 9 Y B dolde BN IR <id
UoreeE W fadd o | @id Yoo fawrs < |

Note:- When you click on File tab then Backstage view will appear with various options for saving,
opening, printing, and sharing your presentations.

S AT B3 od W faad R & O SHECH F 3MTD I BT H B, AU I, fie e SR A
F @ forg f= Reet & | e < |
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PowerPoint includes all of the features you need to produce professional-looking presentations.
When you create a PowerPoint presentation, it is made up of a series of slides .The slides contain the
information you want to communicate with your audience. This information can include text,
pictures, charts, video, sound, and more about slides.

gravdtge ® 7 W glaerd e € e sl doices a9 @ forg sravgedr g1 § | 99 3T uTaRdige
USICe™ 9T €, 1 U8 TS B U ARG A 97 BT B | FAsSd H 98 SFHRY Bl § Ry 3mg s
TP B AT HAE FIAT AR B | 3 AHHN H Sae, o, A1, Qi s ok wise @ aR # 987 @@
oA 8 AHaT © |

5.2.3 Insertion & Editing Text on Slides (F$s # ¢Re §0E HRAT =N UfeT =)

It is important to know how to insert and edit text on slide.

Step 1: When you create a new presentation, the first slide to

appear is a Title Slide.

Step 2: It contains two placeholders: a title placeholder and a
sub title placeholder.

Step 3: To add text, click within the placeholder and type.
Step 4: After entering the text if you want to alter anything,

place the cursor and alter your text.
Step 5: Finish and Run your slide show or press F5

5.2.4 Inserting, Deleting, Duplicating Slides in a Presentation
Oreice™ # WS B g9, f¥eiie ok gelide o)

As now you have created a presentation file then You can also insert a new slide into the presentation
or delete a specific slide from the presentation according to your need.

ST f6 319 UM T USIeI WIge g7 off § AT 31U Uoice H UP ds Weligs W Sl 9dhd ©§ AT U
STavd & TR Foiced W 5l @ wse a1 fSefic ax wad 21

To insert a new slide in the presentation, do the following.

o ¥ 7 weES g A B forg, Pt B AR

Step 1: Click on the Home tab

Step 2: Click on New Slide in the
Slides group.

Step 3: Choose the desired slide
layout from the menu that appears. >

Step4 : The new slide will appear. Click any placeholder and
begin typing to add text. You can also click an icon to add
other types of content, such as a picture or a chart.

M ¢ R s o, Wigs T g # 78 wise W s o iR wige deise g |
Note:

e Select any slide from the slide and outline tab and Press Enter key or You can also press
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HIShINITTE TR

6.0 Introduction (IR=)

Microsoft Access is application software what is used to create and manipulate database. It is the
part of Microsoft Office Suite. Microsoft Access is a relational database management system what
does create or manipulate a database in the form of tables and queries. Microsoft Access helps you
analyze large amounts of information, and manage related data more efficiently than Microsoft Excel
or other spreadsheet applications.

AISHIATE Tad U VeldheH AR 8 fsr ST See¥ a9 iR #igele axa & forg far mar
2| I8 WIRHNTC JAMfhd T BT Th 91T & | AISHNTE Taid Uh Rel¥Md Scled Hioie RReA § I ¢ad
3R FI & ®Y H IS Bl AT AT HAYelS FRAT T | AIZHNUC TR N 3MYH! I A H AN
fawelyor &, iR Hafdd SeT & AShNTe Taid AT 3 Biseic URAdIMT @l Jor # 31ffe gererar o
Tafd B H AaE PR 2 |

6.1 Database (Sc¥)

A database is a collection of data that is stored in a computer system. Databases allow their users to
enter, access, and analyze their data quickly and easily. They're such a useful tool that you see them
all the time.

STIE T & Udh WIE 8 ol dYey RIRed # WIS 81T 8| S« 30 SUANTahdisi &I 3a" <l Bl
el 3R M | Tt HY, TR I SR IRl o e @) orgAfd <d 81 9 g Swrft Suaer € fa
AU I W I T B |

6.2 DBMS (Database Management System) (ser@ o RveH)

A database management system (DBMS) is a collection of programs that enables users to create and
maintain a database.

STEY Hiotic RIeH Ud UPR &1 AfcRR Ubel BT 8 Sl Scldd fhde &+, Hgele d=1 Ud 3Mse
H H YA BT B

6.3 Microsoft Office Access 2010 (ArsshiTTe A =T 2010)

In Microsoft Access 2010, you can build web databases and publish them to a SharePoint site.
SharePoint visitors can use your database application in a web browser. Microsoft Office Access 2010
offer benefits in traditional desktop databases

AP SFfhd Tad 2010 H MY A ST BT 99 (FTIE ©f¥) R fhye vd {6l eRdige dse w®

UfeeT3T ) Fhd ¢ | ANTISe Frge fAfSe o= dig W) 31T &1 SCe 99 JTSoRk § gidlel B Ghdl 2 |
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The Access 2010 user interface has also changed. The Navigation Pane replaces and extends the
functionality of the Database window. In Access 2010, Backstage view grants you access to all the
commands that apply to an entire database, such as compact and repair, or commands that came
from the File menu.

ATgshIAITe AP TR 2010 BT JoR SeXBY Usdl W d&cl A1 2 | S el d AR U &1 iyl
g W FHTHI ARG o B | AgdUe Sfffhd Tawd 20109 %S o 7 WO S9N @AYo wwifdd
PHS Pl TR BRI Bl GfAET @ T 8 oI Hirae vd RUR R wrgel A I FwifSd a9 $r |

Note- Microsoft Access 2003 uses .mdb (Mounted database) file extension where as Microsoft Office
Access 2007/2010/2013/2016 uses .accdb (Access database) file extension for the databases they
create.

6.4 Opening Microsoft Access (ATSHIETE TaIH BT MU BRI

Here come the steps to open or access the Microsoft Office application

from your computer system...Method1:- Start>>All
Programs>>Microsoft Office>>Microsoft Office Access
2010/2013/2016.

Method 2 :-Press Window+R key then Run dialog box will be open. In
this dialog box, we write MSACCESS & Click on ok button.

Method 3 :- Suppose if we want to open MS
Access 2013,

In windows 10, As shown in the figure, Click
on Window button-->Window Menu open--
>In this find -->Microsoft office 2013--
>Select Access 2013-->Click It.

Method 4 :- You can also Type Access 2013 in
Search box, as shown in the following figure--
>Select Access 2013-->Click It.

After open the MSAccess 2013,

6.5 Creating Database in Microsoft Access
(STe¥ ¥ AgpNTe taaw fhie $=A)

In Microsoft Access 2010/2013/2016, there are following two ways to create a database.
e Creating Blank Database
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e (reating Database using Templates

6.5.1 Creating Blank Database (&f® Sce9 fhde &)

You can create blank database using Microsoft Access where we can manually create Tables, Forms,
Queries and Reports in the database. We can add fields and attributes to the table as per the need.

3T ARPNTC TR BT STANT TR i SCId 91 AHd & ofef &4 Scdd # 993 U 9 <fdd, %,
FIIST 3R RUIE g1 Fhdl & | 89 AMGLIDAT S AJAR A 3§ Bles AR VSIS Sl Fohd & |

Here will see the steps for creating a blank database... T8l &1 T& <& ST T & T Q@ |

@ Start Access-->Select Blank Database-->

@ Then File name box will appear with the default file name(Databasel.accdb). Enter the new
name(Balaji MegaMart) for the database. If you want to change the location of where to store
the database, click the folder icon and select a location.

R wge dfed fShiecc Wigel =¥ (Databasel.accdb) @& WTT UGRId BNT| S & folg a1
9/ (Balaji MegaMart) <% X | 3R AR MU TTIH BT TR B FT WJF d8e dred 8, af
Bleey JAShH W factd Y 3R TH W o |

@ (Click on Create button. f&Uc decd W fdad o |
& Database created and Access open with a new table (Tablel) in Datasheet view.
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After creating a Database with Blank Database template. Now we will see how to create table in the
database.

=ih SIS THelc 9 & 915 | 319 89 <9 fh ST & e &9 991 2 |

Databases in Access are composed of four objects: tables, queries, forms, and reports. Together, these
objects allow you to enter, store, analyze, and compile your data however you want. All four object
interact with each other to create a fully functional relational database.

TR H Sed TR elfeidel odd, IR, BiY 3R RUE ¥ 991 B/ar &) 9 ¥, Y sifeside JMUBT 19T
STOIIAR AU ST GOl B, FUBIT PR, [ATANUT PR 3R HHISA PR Bl AFANT <l © | T AR Jfeotae
9 TRE BT Reled ST 999 & oIy T g¥R & 1T §evde ovd 2 |

6.5.1.1 Creating Table in the Database (See¥ # <9a fhde &)

The first step in Microsoft Access to store data in the database is creating a Table where data will

reside. A table is a collection of data about a specific topic, such as employee information, products or
Customers. The first step in creating a table is entering the fields and data types. This can be done in
either Datasheet View or Design View but it is recommended to set up the table in Design View.

AT ¥ ST GUBId B B folU HASBIETde TRId | U8dll U Uk fdel 941 & Sfaf sel 7| el U
fafre vy & IR & ST &1 TUE 2, 9 HHAN) SR, Wsae IT HER B b | e 99 &1
UEAT WU Wles 3R ST TBYU g<X oAl © | I8 A7 A1 Seriie F a1 g &g # fFar o1 daar @ A
29T BT IS o # We axA @ fow Revess fovar imar 71

Understanding Fields and Their Data Types

Field - An element of a table that contains a specific item of information, such as a last name.

Field's Data Type - It determines what kind of data the field can store. There are following DataTypes
used in MsAccess database.

Text Short, alphanumeric values, such as a last name or a street address.

Memo Long blocks of text. A typical use of a Memo field would be a detailed product description.
Number Numeric values, such as distances. Note that there is a separate data type for currency.
Date/Time Date and time values for the years 100 through 9999.

Currency Monetary values.

AutoNumber = Unique value generated by Access for each new record.

Yes/No Yes and No values and fields that contain only one of two values.
OLE Object Pictures, graphs, or other ActiveX objects from another Windows based application.
Hyperlink Text or combinations of text and numbers stored as text and used as a hyperlink address.

Attachment Images, spreadsheet files, documents, charts, and other types of supported files attached to the
records in your database, similar to attaching files to email messages.

Calculated Results of a calculation. The calculation must refer to other fields in the same table.
You would use the Expression Builder to create the calculation.

Lookup Displays either a list of values that is retrieved from a table or query, or a set of values that you

Wizard specified when you created the field. The Lookup Wizard starts and you can create a Lookup
field. The data type of a Lookup field is either text or number, depending on the choices that you
make in the wizard.
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7.1 Introduction to Internet
(3T TH URTA)

The Internet is the global system of interconnected computer networks that use the Internet protocol
suite (TCP/IP) to link devices worldwide. It is a network of networks that consists of private, public,
academic, business and government networks of local to global scope, linked by a broad array of
electronic, wireless and optical networking technologies. The Internet carries a vast range of
information resources and services, such as the inter-linked hypertext documents and applications of
the World Wide Web (WWW)), electronic mail, telephony and file sharing.

gevie TXddce HREY Acdd @l ddd YoTell @ W1 g R # fasds @ wed @ fo gewe
maww(a@ﬁ/aﬁﬁ)wmwaﬂﬁﬁlwﬁmwwﬁm%ﬁmﬁwﬁﬁa Ardsife, e,
TR 3R WM edd & Tdgd Jcdd AMAA 8, Sl goldeii~d, TRRGN 3R 3fiftcdd dedfd denfifear
P TP ORI Sl H ST N 8 | Sevic # AT [l AR Al B vF awa sRkaen 8, o gexfoias
ERIRCHRT Sagi< AR doe A8 99 (SY Y S, $oldgitd Hel, callbil R Higd IART &
TATDI |

7.2 Computer Networks (F7gex wicad)

Networking is a technique which is used to make personal computer to multi user behavior. Although
the computers having single user multi tasking operating system or network operating system
(NOS). By sharing resources and peripheral devices more than one user can work at a single resource
or device.

AT U VT ddhiid & FOrIdT JANT T $REX B AeclguR [RfaaR & aRE WaRT o @ forg fam
ST & | TR FRex # RiTe JoR AcceiReT SRS Rveq a1 weas oifmefeT Rew (T9igs) 8 2|
RERIST 3R URGRE fSaTge™ B 1S Hab U | 3(0F JoRk U & RN I7 f$asd IR M PR Fohd @ |

7.3 Types of Network (72a® & oK)

Basically Network is divided into three parts according to the size...
&I W5 & MR W *ead B 4 91 # qieT S a—

* LAN (Local Area Network) - @ildel TR Head
» MAN (Metropolitan Area Network) - #gIdiferest TRaT wead
»  WAN (Wide Area Network) - i8S TRAT 7ead
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7.3.1 Local Area Networks (LAN) (ei®d TRAT Acdd)

Alocal area network (LAN) is a computer network that interconnects
computers within a limited area such as a residence, school, laboratory or
office building. A LAN is a network of connected devices that exist within a
specific location. LANs may be found in homes, offices, educational
institution, or other areas.

T Alhe TRAT Fead (o) Ud HREX -edd & ol U Aifa & o & Fam, e, sanmener a1 sriaa
o & W) HRE B 3MMUH ¥ SISl & | o U Priacs [Sdgd T Uh "Acdd & ol Ud [ARIe I &
AR HiE 811 © | =R, SR, eifdrd AR A1 3 & H o e |ad © |

7.3.1.1 Characteristics of LANs (o9 @1 faivar)
= Coverage area is generally a few kilometers.
FHINST &7 IR W FY bR 7 |

= Using different dedicated transmission medium you can achieve the transmission rate of 1 Mb/s
to 100 Mb/sec or higher, with the further development of LAN technology is currently being
developed toward higher speed (e.g. 155Mbps, 655Mbps and 1000Mbps etc.).

fafr=1 Sfeacs giafiem Aifead &1 ST &xa sma 1Mb/s & 100 Mb/sec a1 S @1fda grafRm
W U IR FHd ©, o WEifel & oml & e & W agae | S= i G 155Mbps,
655Mbps and 1000 Mbps etc. 3nf3) &1 iR fawRyd far <m <= 2 |

= InLAN you can run the multiple devices to share a transmission medium.
o H oy SfAeE "reH BT AT R & foy aMe fSarsy el Ao € |
*  You can use the different topology mainly bus and ring in LAN.

T oF H g7 w9 99 iR R & A= Siefon o1 SuanT &) wad ¢ |

* The communication quality is better in LAN, the transmission error rate are low as compare
to WAN.

LAN # S9R o< 98k &, WAN &1 a1 d giafes Jfe &R 49 2|

= A LAN usually has low cost, installation, expansion and maintenance and LAN installation is
relatively simple, good scalability.

& LAN # 3ITdR W $H oNTd, SIToHT, R ok Y@@  8idr ® iR LAN IUeT Jeldhd ¥R &,
IS AT B 2

7.3.2 Metropolitan Area Network (MAN)
(Agifere AT sea®)

A metropolitan area network (MAN) is a network that interconnects users with computer resources
in a geographic area or region larger than that covered by even a large local area network (LAN) but
smaller than the area covered by a wide area network (WAN). Large universities also sometimes use
the term to describe their networks. A recent trend is the installation of wireless MANs.
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T #gdifered TRar Aeas (MAN) U VT Sedd € Sff U RN & a7 & # $ex WrEl & A1 SusnThdial
B UH I$ WM &7 9cad (LAN) § FoR F=am 8, dAfe 1o fOxga &3 wicaas (WAN) )1 &R 5y 77 &3 9 Bier
BT 21 93 favafdemer @t w—ft oo Yeda @ aviF T B foIY 39 T BT SN dRd ¥ | UH FdIaH ygRT
R MAN @7 ReImoeT 2 |

7.3.3 Wide Area network (WAN) (args TRar "eas (@)

The network which is spread over the globe and covers entire world, is

facilitated to a computer by Internet Service Providers. It is biggest network
across the world in that each computer is connected and share or access the

data and information. This very network is used all the way now-a-days for e.g.

Finance sector, banking sector, Share Markets and many more. Through Wide Area Network, we can
access the information stored far away on the web server in seconds. The only thing we need is to
know the address of that data or information stored.

qead S g R H BT BT 8 3R YR T Bl HAR BRAT ©, Sexc Hdl YR §RT BRCRI R $exe
@1 Gl Ue FRaT 2| A8 IR R H W 991 Aead 7 O UA% $RER Fhac Bl § 3R eI iR
SIEHRT ATST AT T xdl © | 9 Acdd &l SUANT Iuidhd &< a9 fhar 9l 2 o f SeevsT &
forg faw e, 9% &3, IR IR g | arge URAT ead & AT |/, BH Was H 99 R W R 9! g
SFHN T Ugd GHd © | DAt T Al Sif g4 AT 98 § I9 Sl AT WIS ISR T T |

The Wide Area Network can be in the following form
q1gs YRAT Aegs fA=faRad wai § ST ST @

1. Wireless Network 2. Public Network 3. Private Network

1. Wireless Network (qRRei #cad) Wireless networks are an important technology through which
we access internet or local network computer or resources very easily. Now-a-days many of

universities and industry campus are setting wireless router or antenna which is accessed through
Bluetooth or VLAN.

IR Acad [P AedqUl cadrol © e Add I 89 Sexie I WM Scdd $Rex AT WAl Bl
M A Yo B & | Mol M [deafdened 3R ST IR JRRe™ ISex AT YT RIIfud - &R I8
¢ Y T AYAYYT B AAH | Qe AT St © |

2. Public Network (4fsi@ -ica®) : Public networks are those networks which are installed and run by
the telecommunication authorities and are made available to any organization or individual who
subscribe. Examples include Public Switched Telephone Networks (PSTN), Public Switched Data
Network (PSDN), Value Added Service (VANs/ VADs) and the Integrated Service Digital Networks
(ISDN).

yfedid edd 98 Nedd BT § Sl Colldrgde HUdl gRT Femdr Sar 8 iR fHdt ft offfaEorem
e Td Al & forv Sueer BT 2| SR & forw ufeds Rass Selle™ Acds (Mvwdiyq), ufedd
Raes SreT icds (GgEe), 9 USs afdw (d1gud) Ud schics afaw fefiTed Aead (3msuasies) |

3. Private Network (Wigdc 9cd®): The basic technique used in all forms of private WAN is to use
private (or more usually leased) circuits to link the locations to be served by the network. Between

these fixed points the owner of the network has complete freedom to use the circuits in any way they
want. They can use the circuit to carry large quantities of data or for high speed transmission.



Internet, Networking & Cyber Security (LIS \\1 83

digde 99 & O BUl § SUANT B S arell JoT debie Hedd gRT & S drell SET Bl Sied @ oy
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T FERv & oy R AHhd B |
7.4

Difference between LAN, MAN and WAN (@9, 9 @2 a9 # 3I=R)

The terms LAN, MAN and WAN are widely used in Technology(Internet world). There are following
differences between LAN and MAN and WAN.

LAN, MAN 3R WAN ¥ Heifiiat (Sevrie @1 g 3§ @ wu ¥ SN fhar & & | LAN, MAN 3R

WAN & dr= 3idqv fAe=falaa 2—

LAN

MAN

WAN

Full Form of LAN is Local
Area Network,

SHH {A BE dAlbd QR
Jecad B

Full MAN s
Metropolitan Area Network.
AP A B Hgifered gRar
Teqd B |

Form of

Full Form of WAN is Wide Area
Network.

SAPHT o B dge URAT Acad Bl
=

LAN is a group of computers
and other network devices
which

together.

are connected

LAN, TR iR q@R ead
fEarg<t & T W ® o uh
AT Hae B |

MAN is a larger network of
computers and other network
devices which are connected
together usually spans several
buildings or large
geographical area.

MAN, ®ReR 3R W Acad
fearsdl &1 T g1 Fedd § o
UH A1 Hde 81 & SMHAR TR
gad! W aMe fafee a1 S
Hferd & d® Well BT &

WAN is a group of computers and
other network devices which are
connected together which is not
restricted to a geographical location.
Internet is WAN.

WAN, $9ex 3R TR eds feargar
HT TP TS BT © Sl Udb A1 Hiae
B & &R o WMo we de &
Affa 781 8 21 Sce P dlgs
oRAT g BT B

All the devices that are part
of LAN are within a building
or multiple building.

All the devices that are part of
MAN are span across building
or small town.

All the devices that are part of WAN
have no geographical boundaries.

Tt feargd < WAN &1 Ui €, &) 3ls

1 fargd S LAN &1 uié | 91 fearss St MAN &1 d1é €, | wiiiifere drr &0 el © |

g e et o1 Acdivua | R fRfesT a1 812 wex # B

fafesT & fidR 8 21

LAN network has very high | MAN network has lower speed | WAN speed varies based on

speed mainly due to
proximity of computer and
network devices.

PR AR “ead Szl &
fdedl & BRU A9 Acad |

T8d % WS 2l 2 |

compared to LAN.

MAN -cad &I s LAN @l
oI H B9 B 2

geographical location of the servers.
WAN connects several LANSs.

WAN & e 9k & 9Imferes e+

P AR W A= B 81 WAN a7s
LANs &I ®+dc Hxal ¢ |




E-mail, Social Networking,
E-Commerce & Digital Marketing

U1, WIvTd Acqfhl, S—hd T4 fefoied Arfcn

8.0 Introduction (uft=)

Communication has been the vital tool in our daily life routine, Business, Education, Research and
many more. Communication impacts a vital impression in any sector of life. Email, Social Networking,

chats, blogs and many more are key tools used in
communication. Without effective communication,
collaboration is not possible. You can collaborate with
your business partners through the internet.

FIR BAR Qe Sl & faeai, eradr, R, seEem
IR FE o § Al SueRw BN § | WOR Wfied @ fal o &7 # Ue wewqel v e B e,
A SedfdT, de, & AR B A WaR W SUAN fBU M drel Aol SYBRY €| TR TaHRY
FHMGIA & BIEARIE GG 8] §| §e¥ic & ARIH W AU AU R{oHe e & Wi Pleane ax
[ ¢ |

8.1 E-mail (3—7a)

Electronic mail (email or e-mail) is a method of exchanging messages ("mail") between people using
electronic devices. Invented by Ray Tomlinson.

gAdGiNd ol (IS I §-He) Seldgid IUBRUN BT ISYANT R dlel ARhAl & 19 e ("HA") B
HMEH-YEH T @l Ud fafy g1 X SHfoidd gRT $7a & IR foam |

Features of email (37 & faviyam)

* Communicating through Email is the most cost effective communication. Most of the web-based
email providers are providing this for free.

A B A W FHMDIA I BH ARG BT HIR AR 2 | AR J9—IMeIRd g9 Wiaser 39
A0 H Y& R E ¢ |

*  You can keep records of email sent or received in your email account. You can retrieve the
records of that in future any time.
3T IO S @I H A Y AT W R T G & RS 7@ whd § | o Aoy # el o v @
RPIE B g U o qad 2 |

* To send email message to another person, only you need to login to your email account from
anywhere across the globe.
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et afda @1 9 dew 4o @ o, dadt Mud! g R H FHE W N U HA W B AR
BHRAT BT |

You may keep soft copy (e-copy) of your important documents attached to your email account.
All of the emails providing companies give you sufficient space to store your document. You may
access these valuable documents from anywhere.

3T 3 $9T W W IS U Hewdul TSl @1 |ide HiUl (3—MUl) & Fahd © | A 39 I
H ATl HUMIT SAMUBT U Sfagiic WR/HT B B forg gu verE It &) 3Ny 39 9gged
SIS B FEl W TR B Ghd B |

8.2 Structure of E-mail (3—7a &1 &FNR)

Electronic mail (email) provides us a way of sending messages at lightning fast speed.

gAaIE Al (SAe) BH OO T A A< Ao BT UH ARIH UG a2 |

The structure of email address: Every email address has three main parts.
A T BT IR W F9 I D O T AT B B |

Account_name@ domain name.com

Domain name: This part of the email address is the name of server that hosts your emails. It is
not necessary that the domain name would always be of a .com kind. It can be anything from the
standard list of domain extension (e.g. .org, .net, .gov, .co.in etc.)

TWE A9 : 30 U9 BT I8 R’ GdR BT M B S AUB A Pl SRS bRl & | IS NI ol 2 b ST
FHYT .com & TRE BNI| I8 S TSI B WSS foe # (ON .org, .net, .gov, .co.in 3Mf) & & N &
qhaT B |

A server that could be of a free web-based email service provider (like Gmail, Hotmail, Yahoo
Mail etc.) or server may belong to a specific organization (for example, if you're working in a
company named XYZ ... the server name could be xyz.com).

e FR Sl Udh g 99—IIRT $e i Mager (O SiWd, gfcid, a8 3 onf) 8 §ar § a1 9 TS
foftre A e &1 &1 wear € (SeeRw & forg, afy g XYZ 9 @ duel H W R @ § .. GdR BT A
XYZ . com B Hadr 2)

Account name (or username): An email hosting server may host emails for one person —or
millions of persons. All the email account names on a server have to be unique so that the server
can send emails to various accounts without any confusion. There cannot be two accounts with
the same name on a server. Therefore, two xyz@gmail.com are not possible. But
xyz@gmail.com and xyz@yahoo.com are possible. The account name (i.e. the part before @
sign) refers to the user/owner of the email address.

QAT A (@7 SUERTHAT M) @ U6 $9e BIRST 9aR e Afs A1 @l aindl @ foly $9e B 8RR R adhdl
2l U IR R 9§99 @ & AW G B A1ty a1 wdR 3 5 9w @ Rf @rdl § S o e
S| R W UG 8 I & A @A T8 8 wad| el & xyz@gmailcom wwa & § e
Xyz@gmail.com 3R xyz@yahoo.com @ 2| @@l W @ /fE ¥ Ugd & 2 3G W
SUATTHT /M BT Fefid BRdr 2

@ Sign: This symbol is used in an email address to separate account name from domain name.
The part of email address that comes before @ is account name and the part that comes after it is
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domain name. There must be ONLY one @ sign in an email address. If the address does not have
this sign —it is not a valid email address.

@ 91z : 59 R &7 ST $89¢l O ¥ SAF A9 I WAl A9 Bl el &+ & oy fhar Sidr 21 @
I g M dTel S8 YA bl WHT, WIdT A © AR §Ed d1e M dTell WHT, SIAF A1 8l & | 38l ud ¥
Bdd U @ g 3 a1ty afe oo o us fors T B, ) U8 99 S9d US9 el B |

Note: Email addresses are not case-sensitive. This means it does not matter whether you write
address in uppercase or lowercase or mixed case. (ONLY rarely the account name may be case-
sensitive but domain name is never case-sensitive). All free web-based email services use non-case-
sensitive addresses, therefore tbalaji.pub@gmail.com is same as TBALAJI.PUB@GMAIL.COM.

A U0 dA-—Afed Tl B € | $HBT Aded T8 § {399 DI B A1 TSl b MY RGBT AT ARG
a7 g o9 & ual fored €| (Baa e & B @il A1 da—wared 8 FdhdT § offh S/ A1 Bl |
- e BT 8) | W Feged d9—smIRa $Ad WA AF-$a—ded U P SUANT Bl g,
$AfTY thalaji.pub@gmail.com, TBALAJ.LPUB@GMAIL.COM & o € |

8.3 Creating an Email account ($¥%e QT §9114T)
Follow the steps below to create an email account: $3e TwS< T & fog ww

Suppose you want to create a gmail account.
AN NRTT 1T U@ SfiAel IPIST §99T aTed & |

Step 1: Type accounts.google.com on the address bar of the web browser. And Go to Google account
creation page.

99 ISR & Ugd R W accounts.google.com TISY X | 3R Tl rhrST fhued Ut U Sy |

Step 2: Click on Create account.
Create Account TR feid & |

Step 3: The sign-up form will appear. Enter your first and last name.

Step 4: In the "Username" text box, type in the username you want to use for your email address.
This is the name which appears before the "@gmail.com" section of the address.

"Username” R dfq #, JoR-H TEY X T4 31U 0 9 Ud & oy SUART =T a8 & |
JE I8 ¥ & Sl U & "@gmail.com” ¥ Ugt i@ I@m © |

Note: If your selected username is already taken, you'll be asked to choose a different one upon
clicking a different text box on the page.
IS JAIHT FJT o9 Ugel ¥ &1 foram a1 2, A1 MU U § W TP e e drdd )
e ovd W UF fINe oR TH AT BT MR BRTT |
Step 5: Type your preferred password into the "Password" text box near the bottom of the page, then
type the same password into the "Confirm password" box to the right of the first password
box. These passwords must match before you can proceed. (As per Google's instruction

always use 8 or more characters with a mix of letters, numbers & symbols)

U9 & A Rod "uas” TaRe 99 oAl JHdIGT URIdgs sy &N, R S¥ Uae Bl usel
R |

Step 6: Click on NEXT.
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Step 7: Enter account recovery options. While not mandatory, you can add up to two types of account
recovery options to your Gmail profile:
rHSe RFpadl e 72X B | Y 394 Gmail MEEa # T TdR & Adbke Repad e g
AHA 8, TN T8 AT T ¢ |

= By adding Phone number— Type your phone number into the "Phone number" text box near the
top of the page.

B AR SSAI— 0T B R I8 & A & U "B qR" TaRe dia 7 T8y N |
* By adding a new Recovery email address— Type any other email address into the "Recovery
email address" text box near the top of the page.
1 R /A TS Se- U @ MY & e "R /A Tg9" SRe 9T H Pls 3T SHA Usd
TIST Y |
Step 8: Add your date of birth. Click the "Month" drop-down box and select the month of your
birthday, then type the day and year into the "Day" and "Year" text boxes, respectively.

AT o fafy S| "Rt WR fidde BN T Siu—sred did R T Sfed & eI Bl 9T
PN, R wer i d ad "Day” 3iR "Year" <oRe dfad # 3ifdhd @ |

Step 9: Select a gender. Click the "Gender" drop-down box and then select one of the gender options
in the resulting drop-down menu. Click NEXT.
& SieX &1 999 x| "Gender' $I—<6H dfad W fads &, iR i aRumd gu—sre ¥ #
Siex fadwedl § & UF &1 799 aX vd NEXT 9 W fadd o |

Step 10: Verify your phone number. If you added a phone number as an account recovery option, you
can verify it now by doing the following:

AU B HaR I By, Al MU pece Rebdd) MWE & wY ¥ Td B9 [e) oiel g, df
A 9 B RS 3 [T PR Fhd ©

® (Click SEND when prompted. A one time password is send to your mobile number.

Hpd e R SEND W fodid & | 99 <gd Uds 3P Aldse da8 IR Foll ol 2 |
® Open your phone's text messages. (3779 BIF & << HSl @il |)

® Open the message from Google (usually a 5-digit number) and review the 6-digit number in the
message.

Google ¥ ¥ Wiel QMAAR TR 531y AwE) iR Hawr H 6—3(dbI AT &l FHlet o |

" Enter the 6-digit number into the text box on the Gmail page. Click on VERIFY.
S U1 & TRe dfadT H 6 il B HET Tol oY | RIS R s

® You can also click the Not now link to skip verifying the account recovery options for now.

39 3fd B o rer g fdded BT A9 $R1 & o8 Not now i W 1 fdeies &R Al © |

= Scroll down and click  AGREE. It's at the bottom of the terms of service list on the left side of the
page. Doing so will accept the terms of service and sign you into your Gmail account.

9 wpier ¥ SR [ AGREE W foers @} | 98 US & a8 R Har ol @l vdf # Fa9 H9 | gar
BT I AT B I PR BT S0 3R 3T 370 Sl W H Y3 B dohd ¢ |




Soft Skill & Personality Development
dArre R v Afdaa faer

9.1 Introduction of Soft skill (dfre Rear &1 TR=)

Skills are the property of a human being which he/she gains practically in this real world. Soft skills
are the keystones to success. Soft skill is something which teaches you to behave and present your
self somewhere. It is an etiquette which is needed in an office environment to work and behave as
well as team work. This includes number of entities as to know and learn which are Labour laws, Self
Management System, Time Management, Ethics & Values, Team Building and Personality
development.

Red 9 @1 FURT 2 Sl 98 39 aRldd g1 H APEING ®U A U< a1 © | Aite Rped dherdn o
ol 21 dive Red 1o W A 2, S MUP! @8R HRAT Td AfITd $T RS0 Heem Rt 2 | a8
T VT RICER 8 R &R &/ 3R ¢ & BM & A1—d1 Jd8R )1 & (oY U SR & dilar]
B MITS B T | SHH S B, W TS YOS, AT waee, Afiadr iR el I fafesT ok @fi
e & aR # S SR W & oY B3 ATaRIRS Bleret d o7 et |

9.1.1 Importance of Soft skill (dfvc Rebd &1 #5)

Soft skills play very significant role in our day to day life. By using soft skill you can easily handle
interpersonal relations behaviour. You can take appropriate decisions and communicate anything
effectively. The most important soft skill are given below:

dire Revd gIR fRF-ufifed & e 3§ 98d Aeaql e Rl © | dive Rebd &1 SR &)a 3T
I ¥ IR Hael B W Fahd 2 | 3 Sfud ol of wed € SR widt w9 & g o darg aw
A6 2 | Aeaqol dire Rever i fag 7y §

= Communication skills - &R e Raed

* Body language and Decisions Making - df<I oivdai 3fiR fof o n

=  Self Motivation and Leadership Skills - ¥e% #ifede™ iR o=l Raew

*  Team-Working Skills - 1 afd1 Raed

=  Creativity and Problem Solving Skills - Fa-TH&T 3R FHRIT B AT & DI

* Time Management and ability to work under Pressure - ¥ J&erd iR am@ # &9 &< @l
&Hdr

9.1.2 What are hard skills? (g€ R Fa1 &?)

It is teachable and measurable abilities, such as typing, computer programming knowledge, writing,
reading, knowledge of Machine operation etc. By contrast, soft skills are the qualities that make you a
good employee, such as etiquette, communication and listening, getting along with other people in
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good manner. It is important for you that you can get good job and honour if you have soft skills
along with hard skills.

IE ggM AT IR AT Iof FT e B, O fF e, Feger wnfi e, okad, ured, wiE Harers @
94 ofe | g9 fawid, |ite Rl # U TOT € ST 3MUBT T 36T Bl 91 &, o RICMER, FaR 3R
AT | SO ARIAT & AT 378 WG & 1 e | 3mues forg dotia! 8, Ife 3 8Te Rbdd & A1 e
Rl BT BT S T & AT MY AT Add U IR & <1 M W U e Fahd & |

9.2 Personality Development (fda faswmm)

The term personality has been derived from the Latin word persona which means masks. It is totality
of one’s behavior towards oneself and others. Personality Development includes everything about
the person as his physical, emotional, social and mental behavior.

e oI @ S qITy wHiferc] (Personality) &7 wnfeqd a1ef Y &afdd & ar@d Ui A1 9T&T SRV B
ST BRAT © | I IS & YAl Tea olfe 197 & wes gl (Persona) ¥ 997 & ot a1ef gaier
2198 W 3R g @ U TP AR & AR B WU 2 | THAITIC] STouie & Jf=rid fhell o @fad
BT ANIRD, WIHIHD, AHINTG R ARG FdeR AfAferd gar 2 |

What is personality (&f¥ia &1 27?)

Personality is the inclusion of your feelings, behavior, symptoms and innate qualities. Said in easy
language, personality is a combination of traits, qualities, thought patterns, emotions and overall
behavior that a person follows naturally in their daily life.

3IYH] TN, FGER, WAefvi 3R SIeI 01 BT FHGY & Afddd © | M A9 4 Hel SR A1 ki
eron, qot, faeR Yesl, werel 3R WY FEER &1 WA © foradl uTed Ud Afdd o Qfd S |
PHId TR W FRAT 2 |

9.2.1 Motivation - 3R

“A great man is one who can make a small man feel great, and perform great.”

g% A Afh T8 & Wl U BIC ASH BT 78T AeGH B Tl 8, 3R ITY 78 $R FHRal Faalm 8 [

Motivation is very important for the overall development of the personality and mind of the people. It
also puts a person in action and in a competitive state. Furthermore, it improves efficiency and desire
to achieve the goal. It leads to stability and improvement in work. It helps the person to fight his
negative attitude. The person also tries to come out of his/her comfort zone so that she/ he can
achieve the goal. At last we can say that motivation is one of the key elements that help a person to be
successful. A motivated person tries to push his limits and always tries to improve his performance
day by day.

IFRET ART & fthed SR 79 & §AY [Aard & foly 9gd #eayul 2 | I8 Udb Afh dl HRaTs 3R Ao
Rerfay # Al <1 21 59 felan, I8 SECT IR A&d WIS PR B $T@T H IR BT © | 599 B H ReRar
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3R YUR BIAT 2| I8 ARH BT SHD AGRIAD AT | e # 7S ol 2| AP 3T FHe o F aeR
3 B PIRMT XA & b g8 e BINT PR Teh | 3 H 8H BE Wbl & [ob AUV I YHQ ofeall H &
TH & O fhdl @afth &I A%hal 89 H AaE B € | Ud URT s 3o AH1si B qe™ &I IR &l &
3R e feA—ufifes o= weelH &7 8aR 94 &1 HIRET &R © |

9.2.1.1 Role of Motivation In education (R # ifgRer &t yffar)

Motivation is another important factor in learning. Without motivation no learning at all will take
place. It is a process of arousing and sustaining interest in an activity in order to achieve a goal.

AR WREw & Ud FedqUl RS 7 | AR & a1 IS ff e &1 e 781 8N | I8 Ud e Bl
U B @ forg v Tfafafyy # v S SR 99 @ @ Us i 2|

Set a goal and crack it

ey fAuiRa & R S D BN

If you are a student and aimed to crack Civil services exam or any other examination for getting job,
you should know about strongest work ethics. Friends, it is not easy to get success in any competitive
examination, so that you should develop a strong work ethics during the educational process.
Friend this golden time will never come back. A little effort every day makes a man successful.

i 39 TP BT § 3R Sifd & oy ffde a1 uden a1 foefl 3y wRie &1 Hb PR B ded W §,
3MUPT [ AT PRI & G H S a1y | Qal, fobedt ) Ifrnft oiem # Fwerdn o BRAT SIH
TEl ®, SHferg MUl fed Uihar & IRM UH Aolga BRI AN IR $RA M | R I8 gAY A9
F aTO T8I AT | T &7 AT AT IR T A P AB I 2 |

You have to follow the rules given below to crack examination

YT TRNETT DY Hh B P forg -1 T 70 A=} B1 urer T H=AT BRI

= Make your vision clear, improve your confidence, improve self-awareness and keep positive
attitude.

3T faSH BT T N, AAAITATT BT IG1, TTRET & Td AHRIHAD GRHIV I |

= [f you are preparing for UPSC, State PSC, SSC, Bank etc,you should collect the study material
according to syllabus.

i oy gdigadl, o9 GIUERT, THUERT, §% offe 1 TR @R e 8, A1 AMUD! UIGHHA B AGAR
e A UeE ST ARy |

=  Planning is the first step towards success and to execute it the next step. Prepare a detailed
action plan and monthly plan for study. Break the monthly plan in weekly/daily plan. Strictly
follow your day plan.

IS BT BT 2T H UBAT HeH & AR TABI T HEH /A ST © | 3T & oIy T faqal
BRI A 3R ARID AT TR BN | ATlRd / fFh Ao § J1ie AoT & ars | g s &t
AT BT T | ATl B |

= Make a timetable to execute for daily paln at least eight to ten hours. At the end of day assess
yourself and read the plan of the next day.



Soft Skill & Personality Development €© 1 Balqji \\223

B W HY AS W 9 g afd e & foru fFefed o= @ forw v aag aiRefll 97| fog & siq o
G BT ATHAT DY 3R 37Tl & Bl IS Bl 3T BN |

= Solve mock paper regularly. Make sure you have enough time on your agenda for a minimum
two revisions. If you going to face UPSC/State PSC (prelims) exam you should review twice both
general studies and CSAT syllabus.

A R BT AT SU A 8 Y | <AGH &l RAo & folg oo vols H gaia |99 &1 gHfded o |
e g AR /I qroadt (fiferd) TRIem B WA FRA S I8 E, a1 SMUd! | IR iR
AT Ureshd I &1 FHIET AT A1 |

9.2.2 Self Discipline (31 Irgema=)

One is needed to make oneself disciplined and mannered according to the nature of job and objective.
When one is selected for a post then he/she is trained in a disciplined way according to the nature of
the job. As we maintain discipline in a company according to the rule, in the same way we must make
ourself disciplined in our daily life routine to execute our personal task and management.

HH B UG Td I B AR WA B NI IGT Maedas 2 | o fhedt f @fdd &1 v ue & forg
AT ST 8 A1 SY Al & gy @ TR ARG ¥ o giifaa fear Simar 21 R UaR 89 U6
H Ml & IR AT I¢ W 8, S A8 B4 AU ARKTT BRI R YEET I PRA B o U

< STia @1 et § ga &1 SR k@ anfey |

9.2.3 Building a positive personality and gestures
(APRIAS Ahvd SR FART T A7)

Your personality is very important in achieving success. In fact, we are told to focus on 'personality
development' in such a way that we can achieve our academic success as well as commercial success.
It is worth noting here that personality and success go hand in hand, yet some people are unaware of
this.

HHETT BINTE PR H 3T Al Bl dgd Hewqul AN Bl 8 | araid ¥ ‘AfRia [ W) 59 THR
€T Bfad B BT BeT Ol & T §H 3 Aefd AHerdl & AI—A1 AGAAS Fherdl I ST
IR D | Jgl W Tg 910 &H o1 I © Al 3R Aheran we—dre aod 8, R W go | 39 9
H T B

9.2.4 Time management (9 Yd¢)

Time management is said to be carefully arranged and the time taken to perform different tasks.
Proper time management provides efficiency, increases productivity, and completes tasks at the right
time. Time management is the act or process of planning and exercising conscious control over the
amount of time spent on specific activities, especially to increase effectiveness, efficiency or
productivity.

A== Sl & IR B I T Y G 3R @] B & HH B Aa—fAaR IR qaRed AT IHg
YEET HEANT © | A THY YEEd W Qe el 8, Screddl dedl © IR P el 99 R R B © |
g wdae fafdre wfafafel R @d fhe v g & A W ARy wU | ywraeiierdn, <erar a1 Scrgdd
qeM @ fore Ao r a9 &R w9 fora=or & e ar ufthar g




Data Entry Computer Skill Test
& Computer Typing

STel Twgl, hreX bl T Td e ersfu

10.1 What is Data Entry? (STeT Ut &1 87)

Data Entry is the task of entering or updating the data into the computer system by using particular
software. It is used in multiple sectors such as banking, IT businesses and others. To enter the data
entry job you need to be proficient with your typing speed and be
able to type 50-80 words per minute. Some data entry positions
also require a typing speed of over 80 words per minute. Data

Entry jobs could be manual as well as automated. Computers are

used in automated data entry because they are highly accurate and designed especially for this work.
In manual testing, you have to be more concentrated and focused on not making mistakes during
data entry.

ST U1 ORIV AHeRR &1 TN HRdh SRS RRSH § €T ol B AT IUSC I Bl BRI & | ST
SYANT g &3 oI ST, ML haardr AR =T # fhar ST €| ST Ugl Wie § WY R B folw S
AU TRl Wi & A {Eid 8 Aty iR ufd fie 50-80 ¥R TISU FRA H WeM B AIRY | §B STl
yfafte uat & forg +ft 0 o Y frie & e @f i wie o smawgaar exft 2 | <Ter Ugl Sifg Herd
& T AfcHce Wl B Addl § | HYCSR B TN wWarferd ST UGl H R S 7 R®ife 9 s
Fe B § SR O w0 9 39w @ forv fRomea foy o €1 fwgerer SReET #, amar et Ul & IR
AT 5 B W MG A Dgd BRAT 8|

10.2 Data Entry Tips and Tricks for Faster Data Entry Accuracy
(321 U few iR fRa A et U Yol @ forg)

Here are some tricks that will help you save time while carrying out data entry jobs. MS Excel is a
fabulous tool for organizing data.

I8 {o fod < S W8 € S MU ST UET Wi PR B SR GG F9M H AUD! HeE BN | THUE
TR el B AARYT e $ folY T AFER < 2 |

1. Customize the Movement of the Cell Cursor (¥ $¥R & YqHT I HEMIZA BY)

Often the cursor position can be distracting for the data entry operators because every time they
press the enter key the cursor will go to the cell down the last one while they may need to enter in
the next column rather than a row.
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IR ST T el & fou R @1 Refay faafera @< arell 81 ¥l & @ifd & IR 5@ 9 vex gHoll
T & a1 PR SifoH Wer H A I SO, Sfefe Swe X B 99T 3T Bictd H Uk BR P AR 8
RETIR

& Click on the ‘File’ menu. Choose ‘File Options’ from the ‘File’ menu.

& Select ‘Advanced’ from the left-side list. Under the Editing Option, ‘you can click on move selection
Direction’. Select ‘Right’ from its drop-down list. Now the users can move the cursor
(Down,Right,up,Left) as per their needs.

BT’ W W faed $X| ‘®ige’ 4 A 'File Options’ T+ |
a1 3R 31 foe | ‘Advanced’ T+ | Editing Option & 3=iq,

AT HeldR SN WR {ded B Adhd © | sHd] giu—sed fore o 'Right’ i | 3@ JoR 370
ToRd @ A AR @ (Down,Right,up,Left) W 7@ ax Fad 2|

2. Data table will make the storage of data easy (ST TIfI®T ST & HULYT BT A 47 <)

Make use of ‘Data Table’ for storing data as it will enhance the speed and accuracy.
ST WR TR & oy ‘ST <o’ &1 ST IR ISP I8 e iR Tayedl o qer |
3. Select the data in the spreadsheet (®Is¥fic # SIeT delde FHIAN)

Click on the ‘Table’ option in the standard toolbar. You can format the table by adding filters and sort
options or can add more than one table in a sheet. The users can assign values in the formula bar and
it will perform the same function as in the case of cell references.Formatting and exporting data is
possible at single click in table tools.

WUSE AR H ‘T’ 3i@M W fadtd o} | 377 fhoex iR Wi fadwey Sgar Sfid & Brle 9= |ad € a1
TP ¥IC H P ¥ AGH A SIs T © | JoR BRE dR ¥ ey AA1ST PR qdhdl © 3IR I8 g8l BRI ST
ST A YR B B H BT B | <9 oo H R fIdAd IR IeT BT Wit HRAT 3R I a6 R |

4. Number List (f&R fore)

When inputting a number in a cell rather than a date, select the cell and drag downwards to copy the
number and not create a linear series so the range is filled with the

same number. If you type one number and the next in the series
below that and select both numbers before filling and it will create a
series of numbers with the same interval between them. You can
create a linear series from a single number by clicking the right
mouse button to drag on the fill handle and select ‘Fill Series’.

P forie & I f<) Il § BIE TR ol B, Al Bl Holde DY AR Fa) B BT 999 & g S &
AR WP 3R T AfR RS 7 9917 aifes 35T 99
dR ¥ fhat 8 9v | afe o Swa A @ AR H Ud
FERT DI Jolde BRI & AR A B IR g & @ I8
STd g 9HH AT B 1Y AR Pl U GRS ¥
SEEY | 3T U AaR ¥ iR WRST 991 9 8§ U
AR TRy W iR a tfed ¥ 0 e 3 SR
S ¥ S fdadd B SR fhel AR Helde axd -
B AR W |
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5. Creating a Series (¥iRel @R &)

Type the starting value in a cell, select the cell and choose Home tab Fill > Series. From the Series
dialog box, In the series in area, select to fill into Rows or Columns. select any Type (Linear, Growth,
Date or Auto Fill) which you want. Set the Step Value, the value between sequential numbers and
specify the stop value in the Stop Value box. When you press Ok, Excel will enter as many values to
complete the series according to the parameters given.

d H YOI I TBY BN, FA g+ IR Home tab-> Fill > Series i | ¥R Srraii dfaq & AR g4
@ TRA 9, 1 AT Sl § W= & oIy Aelae & | fHT g9 (Linear, Growth, Date or Auto Fill) &1 elde
TN ST M AR T WU Iy, RIfage 9 & §/g @1 dR) A N AR WU Iy e # =Y deyg
WRIGIE B | 99 379 M1 341 &, AT Yaidl QY T AIIGS] & IgaR ARG Bl IR/ &= & oIy I deg,
TS BT

6. Make your own Drop-Down List (3ot giu—sre+ foree ¥9R))

Maintaining a drop down list will make a smart way to ensure data consistency. Create a range by
entering items that you want to pick in drop down list, select the cell where you want drop-down list.
Go to the ‘Data’ tab . then select, ‘Data Validation’. Change the setting and create the list by clicking
‘Allow’. You can mention the range on the source box which you want.

ST IS foRe @I 991 R@ ¥ Sl ReRar GHARed a7 &7 Ud WIC RIGT 99 A9 | $U S8 fore 3
foree amEd €1 'Ser <9 R WY | fihe, ‘ST dferew g | AfeT a5t iR fore Holae oY | A dfaw # fore
B I e o ST M9 AT 2 |

Use Shortcut Keys :

Using short cut keys will speed up the task of data entry.
'7IfE B PN B WA A ST VSl & B § doil Mg
¢ Tab key: To move the cursor to the next cell.
o  Shift+Tab key: To return to the previous input cell.
o  Ctrl+A: To select the entire page.
o  Ctrl+C: To copy the selected data.
o  Ctrl+V: To paste the copied data.
o  Ctrl+Z: Undo the last action.
o  Ctrl+Shift+Z: To reverse the last undo action.
e  Alt+Tab can be time-effective switch between all opened windows.

10.3 Computer Proficiency Test Questions
MS-Word

Question : Reproduce the official letter using MS Word with the font type “Verdana” as per the format
and guidelines given below, run the spell check and correct the spelling mistakes (if any) and save
the file in correct format, Perform the following as per the sample.
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A faw 77 gy SR feenfcdell & AR THUHE 9 T SUANT $Rd U SMUHIRG UF Bl “Verdana” Wi
@ A1 IR, Wl I6 B 3R Wl TR & 98 a1 (Al #1$ 2) IR Bz B 98 Uy H 9T aR,
T & AR f=ferRad 9 o |

There are 3 font sizes of “10 point”, “11 point” and “12 point” and the line spacing- single and double

used in the sample along with right insertion.

“10 point”, “11 point” 3R “12 point” & 3 Wi< MHR T IR Fel Ul & AT T # R iR sae
S WA BT SUANT fohar orar 2|

Not to be typed. All text is in
Font type of “Verdana”

Font Size “12” —> Date: 19t November, 2015
Double line spacing —»

Font Size “12” —» To,

Single line spacing —»

Font Size “12” —» The Director,
ESIC-HQ,
PANCHDEEP BHAWAN,
NEW DELHL

Double line spacing —»

Subject: Submission of the Candidature for the advertised
post in the September 2011 News daily.

Font Size “10” —

Single line spacing —»

Font Size “10” —» Respected Madam/Sir,
Double line spacing —»

Font Size “11” —» This is with reference to the “ADVERTISEMENT” published in
the News Daily on 15th September, 2011 for the recruitment of
Group “C” Category post.

Single line spacing —»

I would like to submit my candidature for the same as per the

Font Size “10" — prescribed format of the application form.

Double line spacing —»

Further, I have read and understudy the eligibility criteria and
Font Size “11” —» process involved in the recruitment and at any stage during the
recruitment process, any of the information declared by myself
found incorrect my candidature would stand canceled and there
would be no claim from my side whatsoever.

Triple line spacing —» Thanking you with warm regards,

Font Size “10”" —»
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= (Critical Flow Model
»  Comparative Analysis Model
= [nteractive Service Model

Slide 3 | E-governance Best Practices

= Higher penetration due to automation

* Increased efficiency due to connectivity

= PROCESS RE-ENGINEERING - technology only a tool not panacea

Slide 4 | E-governance Scalability
»=  Most projects till now have been pilot projects

= A few things to keep in mind
=  Sustainability
*  Training for civil servants
*  Private partnership
= Pilot, Plan, Replicate, Revise and Scale

Slide 5 | E-governance has been responsible for the progression in technology of developing
countries.

2. Prepare the power point presentation according to the instruction given below:

Slide 1 Global Warming

Slide 2 Many problems could result from global warming. One of the biggest problems is rising

sea level. Many areas of the world are experiencing increased hurricanes, floods, and
other unusual weather.

Slide 3 | Climate

It's the average weather in a particular area. It’s the average weather

Over a period a time.

Slide 4 | In conclusion, if we make small changes now in the way we live, we can avoid huge
changes in the future. Scientists, governments and individuals must work together to
overcome this threat.

Slide5 | THANKS

Typing SKill (English, Hindi & Mangal)

T G ¥ gt B S B Wl @ fo 9gd S § | ergfi
P TGN B9 ¥ gF e T ufafes & et i fiex ersfiT, dex

TS, §—Ha WS, WTd Acafh T WiEcH & YANT gIe SN | Tosereen

TR THT 1 <Y TN W PRI R <Y BT F WA Hewyel iR Q T i

I8 8 fb Hrger W g0 Her Bl R ¥ ax 99 916§ Ff G F off 'ﬂ\s,’i‘:‘:ﬁ;m A
[hd & AR TEl W Y bR DI AR T W= 2| o5 s o ||
& T 3N Bl TN B 3T I B WL U9 Yg b B vy # LC:Q ........ T

A T kﬂ mnv::'nigm
PIErS DI Hordl Bl faror A e T Rl @ SR dReb Siforal Heighe \ l
T FaTe BT AT | M R2 b TRID e 3T BT B AE I | Aol e ah
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I 1Al B B UR AT SMY | TRl & 4 W o7 B (ol WA IR &1 YA I 81T & S & Aed |
BT =AMMRY |

TS & # MU o &1 & ol I8 mawd & b o | 6 uRiers 9§ Anfee™ ura fear i,
TR @IS q1 TS debelol &7 Yo ®U A S 8 ol © | Jedrd Sugdd 3 & Aregd d <gd
HR BT I F RGN O WHAT g | TS I o ARG 91 I8 2 b <Ry B HR goiaar oraN WA
MR &, S 1T e T S Ia (gUraT 39 SRl # w81 |

TY BRI URA B ¥ gd FAfaRad @ erav e # |
® Proper Posture: BIaIe & FH T ¥ I3 |
® Focus on accuracy not speed :J&dl TR &A1 31

* Don't look at the keyboard :®1d€ & TR ol <@, Fifdh DS B W—A@ B TIGY B B ITold
3Ed U TN 8 a1 99 GTHRT UTT Hios 81 Il 2 |

I o # &9 8 9, 39 A W Sferdl B W WD | @ DY QG |

Sl s[5 JRfE Je [ [s [S]e [=]=] —]
1 2 3 4 5 6 7 8 9 0 - =

= |q|w|E|R|T|Y|Uu|Il|O|P]|{ .

Caps Lok G H " .!L —

" Tveny z.'er }

=  Spacebar (®9aR):To put a space in between letter pairs. Use your dominant thumb for the spacebar.
3 vEt @ 9 SR R & fofy W aR &1 W faar S 2, W 9R BT WA B QIR w1 &
SIS & Wew 3§ far e ¥

* Enter key (§¢X @1): Used to move down to a new line. Use your right pinky for the Enter key.
(AT 9Ga @ ol §ex @ &1 YART f5am SIaT 8, S &1 & Ared 9§ IRE% deal Sff el 2 )

*  Backspace key (35®9 @1): Deletes one character to the left of the blinking cursor. ffl ergu fag
MY Feq A7 HeR DI AeH & fog 9a W o &1 W fBar S g |

IqT PAS & ARYH I A GIC §RI IS I Bl GATE BAT ST R8T & P Ul i § gd el @
T AT Bf—

\aﬁa%wﬁdﬁﬁﬁesﬁvaﬂiﬁémﬁsw

SR & IR &1
If | If rf mf if if | if | if mf rf If | If
) 1 2 3 4 5 6 7 8 9 0 -
q| w e r t y u 1 0 p [ ]
a S d f g h ] k 1 ; '
z X c % b n m , . /
If- little finger, rf- ring finger, mf — middle finger, if- index finger
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\aﬁ?wﬁaﬁvﬁwfﬁwaﬂ%ﬂémﬁ@w(ﬁ%a}ﬂm

st g IR BT
If If rf mf if if if if mf rf If If
~ ! @ # $ % A & * ( ) _
Q | W E R T Y U I 0 P {1
A S D F G H J K L : "
Z X C \Y B N M < > ?
If- little finger, rf- ring finger, mf — middle finger, if- index finger

Me— Sad A # fHH) AR 31 <5y B & oy 99 3R &I Bide & |1 & 9T awad 8 |

Sad o Td el & emIE @ SURTT ETiRad STRINT BT BH W BH 20 W 25 R BR d R BRI Bl

A gfoem anfr

3 e & FB TEEYY T

» ST 6 SWRIed 5 Td 91 @ ARgd 9 9 T 7 {6 s @ iR 9 81 @l ggell $en () 9 a,
A I (of) & s, T Sl 7 (mf) | d, Tor et Sl (if) 9 £ der S 9 g dowEq id W
A% IR B A TR Sl () & 5 ol S () § 1 e STl @ (mf) @ k, qor G S
(if) &1 j o S A h arriq asdfg ;lkjh @7 eI Y| & W b SFferl BT SR FRA @ UvEN 37U
AT W W 19N G of |

" PES B B HUR ATl AT BT RN B & folg i 81 a1 ugell et (If) & q, 9 St (of) &
w, T STelt & (mf) | e, o ARl Sel (if) | oraur S Wt aovE e WY SN QIR 81 @
TEel STl (1) & p, S ST (1) W 0, A STH W (mf) § 1, Fon eh Freh (i) F u Gon S ¥
y i qwert poiuy T 3T & | &9 e 6 Iferal &1 TEU dRA @ UgErd o1 Il RIF dHIdre
o1 s1afd asdfg ;lkjh areh €T W 999 @ o |

" PES H A qrell ST BT AT B B oy 9 g1 @) ggen Ient (If) ¥z g Sl (¢ff) 9 x,
T Sl & (mf) & ¢, dr el Sell (if) v ar S A b o U W 9o qlfed &1 @
gEel ST (1) & /, qEd ST (f) & ., G ST § (mf) &, qor D STeh (f) & m dor S @
n 3 zxevb /.,mn &1 W & | & T 6 STl a7 e A & uwErd U JT XA BIErS Bl
srrfa asdfg ;lkjh arelt $ W 909 39 of |

» A BT T A % for 9 ' @) ugent Selt (If) 9 1, S e (of) & 2, AR el | (mf)
J 3, dor Al Sell (i) 9 4 97 S W 5 Jvard s WM SaR QIR g1 @1 gl Selt (If) 0,
A S (1) ¥ 9, I el | (mf) ¥ 8, T @l Swen (if) § 7 den S 9 6 i 12345
09876 &1 v X | & W & STferdl @ TIEY dRe & UTErd U JAT UM B 1 idfd asdfg
;1kjh aTel TEH W AN @ o |

Key Board Exercise 1 without shift key = & 7 @s7 & 50 IR 257 W)

asdfg ;1kjh asdfg ;1kjh asdfg ;1kjh
Key Board Exercise 2 (@ €1 T @139 & 50 R TISY &)
kha lal sad lag fad add

dad jag has jal sag ass
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fal gas kala lakh glad dall
dash lass hald fall shah dada
half gajk jall lash hall alka
glass falls kajal flask fasla sadak
Key Board Exercise 3 with shift key (7 €t Tt @59 #1 50 IR €8T W)
ASDFG :LKJH ASDFG :LKJH ASDFG :LKJH
Key Board Exercise 4 (7t € 74 @59 &1 10 IR TIEY &N )

Kha Jal Sad Lag Fad Add
Dad Jag Has Lal Sag Ass
Fal Gas Kala Lakh Glad Dall
Dash Lass Hald Fall Shah Dada
Half Gajk Jall Lash Hall Alka
Glass Falls Kajal Flask Fasla Sadak

Key Board Exercise 5 without shift key (& Tt @g71 @1 50 IR 25U & )
qwert poiuy qwert poiuy qwert poiuy

Key Board Exercise 6 (7 1 it &g @1 10 IR €87 &N )

low for dog how our huge
road past last less fast they
help rise also like take grow
were type keep girls first apart
total their gopal group would works
years house large judged desired figures
Key Board Exercise 7 with shift key (= <t = @57 &1 50 IR <RT &)
QWERT POIUY QWERT POIUY QWERT POIUY

Key Board Exercise 8 (i < & @59 @ 10 R <I3T 3% )

Flood Petty Drugs Root Pope Equity
Plural Poppet Roop Port Peep Power
Rooty Like Poor War Tie Tope
Towel Swept Throw Repute Work Sorrow

Key Board Exercise 9 without shift key (& T @57 @1 50 IR <57 aX)

zxcvb /.,mn ZXcvb /.,mn zxcvb /.,mn
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IR BT 9g B B
STET B VFHT HVTLHINT BVl
TV B 39T BT

M (ROM) # wufed urum $gd & |

BHIIY

R fodl U @ fF9 &H H gaiiage
AT 2 |

PT—SIBHIS— VTG

TIET B AT ST I IERIT AT T UK

SBIHIT FEerrar &/

Fegial, Ride 3R sifee @Y. Foll PET A & |
Ftewre

PGSR §RT STl BT HYYelc PRA—
graryT FEerar &/
PHFISR BT SYINT B BT o B—
FTYEY 7 PAGATT BYG & 3iIF
78 IIST AT § SIeT Weiv f39r orar 8/
3 @1 g R JArer H i a=a @
AT BT ... PHET ST =2
BT
AT giiaeE § o1 ECS a1ef &
golggifae BT afda
(Electronic Clearing Service)

HNT DdT UgcTl Cb“ﬁLC‘(WC’l‘IMIWWl
Il SIS §RT -1 AT TUH FiFH HFYER

(Mechanical computer) ... o |
vty s
HRIIER AT FTIAC BT TIANT HRA dTel T 3HA
afeid AN & 9 BT AR BT B
fesfieer earge (Digital Divide)

faNd o

schics Afdbe &1 [Aer faet foar o)
0% fFedt (Jack Kilby) e
g Fft (Robert Noyce)

PSR | UYa ISl forg ... a1 B 2|
Rrefi@iT ar srHfFaT #1/

Civil, RO/ARO, SSC, Bank, Railway
Td 39 geTsii H gu U AEdqul ueH

N A= N (aN
¢ AR AHD JATURICT RICH DT SUYINT IHAR

W forg favar Sram 21
SvpCr, HYeIT I IV FYCY
e Bk Rfere fm w® gitRer &k sMg

gAdEId IUBRON §RT 9 Yof Seragitae Afdbe
P HEA |

gdice wfre fag
FFIIER BT SIS Hel Il ¢ |
TTow §9o1

{, IR1B, PrdIer R STCL.... AT B SEERT 2 |
=7 g &idor (High level languages)

faea &1 gom solagiMeG feoiicd H7ger .8 iR
ST enfawpr ... fHar e

ggeT gelagiiag Ieoficar #rgev ENIAC & forear
B & ft v T T gadh 7 AT o/

¢ fOva @1 vem HHRMA TR © foU Sudter

PITAT YT Ugell hFISX AT |

g#d% (UNIVAC)

ENIAC 3R UNIVAC &T 4=1 91 & |
Electronic Numerical Integrator and
Computer, Universal Automatic Computer

T ST & HFgeyl H UYad AMFCddR ofvdol
ofT |

TIHT ofgoT

ARdsh B BRI B Tbol B dTell Fad
Biel 3R |ad qg T a1 Afasy w1 v
=l
FIICH HFGCY
IESTRIT U & IR BT e & oy SuanT
forar <rem 21
OMR

qISRIUNIR b1 A |duerd . sa o fohar
o 3R ARPIUAAR Jad HICR ... STNTH B 2 |

geor (Intel) 9 7 4 FTRIT &

fooy wu ¥ feozT fey U saasi=e o o
forefl o fEarsd & <} B8l 81 4 PEA B

gRee Frgev (Embedded computer)
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¢ fS9 & crer wrs, O A& anfe. ey < 2

@erige FISPHIecT Bar

ART A IHRad =_9 uR HFYex &1 b fobar
AT & |

#—8% (CDAC:Centre for Development of

Advance Computing), go

ART | I IR HFIYR T |
gvF 8000

e &1 g GWR FRIR 2 |
CDC 6600, released in 1964,

Ie ORI 9UmEl & gERT . MELECIIRIES]

R S 2
siFgaT
fIeq & yort YuR HRISY BT AT fBam o |

CRC(Cray Research Company)
qTE f¥wiee SIRFiC ... Ars # fife g 71
e

R HFYC DI ARG T AT WRAY] A
% (Bhabha Atomic Research Centre

(BARC)) gWT fasfia fvar mm 2|
3994 (Anupam)
28 Toe f3arsd &1 IR T |
i€ty (PDA-personal Digital Assistant)
7S QT B HSRT &F Bl Hed o |
AT FraeT
A A, G 9 Ud FaH HEM HFYEX ol

FH 999 H Sfed dAageR IR [HAT § | S
BE Sl 2 |

guv HRICY
Agel B BT IMATHR fhar a7 o |
;T FYY FI°T
STua(DNS) & R 2|
ST 717 @ aEd yd F gRafda e/
VLSIsifse # VLSI &1 4_1 A9 2 |
Very Large Scale Integration

VLSI Tl &1 YT fhar Sirar 2 |

G TTTT F/

U9 §1Sd BT Bl STl © |
USB Flash Drive

SIHEMT HFRIEI BT FHET Il 2 |
¥ieft (PC-Personal Computer)

Ucqd HRISR S M H [ AR-G Bl A
Il &, Heal ¢ |
SEIT IT TNCYH BFYEY
PRI B SIS T4 IATICYS SUBRYT Pl Prglc]
T BT B fHar o 2|
FxIel e &

9 5 B A TP I Af0D URAR TP A1
SN by T €, a5 3% bEd ¢ |

Todt GG

qRd ¥ Ryeha doit Red B
dore

AISH $1 98 UBR Sl ASH Ja< $I Gl T
% fIQ oIoR &1 SUArT Al 2 |

giificwer Araw(Optical Mouse)

PR B fFE 1T BT BT IR HEqH fHar o
FhaT B |

grsagv

AFedIR BT SYANT qoic g9 & forg fopar o
eI

wisdfic @ircagv

FE o e AR ok iy B A omerd
wY ¥ g Wie €Nl URAT BT SR HRdl &
s R emar # gfg et 7

I (Cache)

9 FFYSR W P AR Bl YaIage HRal
2 Al SHRE B & I8 YRIREN ol &

PHE B |
T TTgldeT

X9 3R I Rerg BT &1
7Evars gv
TP soidgite fSarsd, Sl sehies wAfee o 9

g1 BIaT € T SISl B ShHIE W ggoldl ©,
P T |

gEav
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¢ AN BT R AW T
feoficer a¥icrger 1% (Digital Versatile Disc) a7
feoficer fifegr v (Digital Video Disc)

¢ FEYCR P FIH Fe@yol ANT RO Bl e
BT ARAED HBI ST & S Sl Pl UR™ B
Jfgef o & uRafida a=ar 2|

wrig (CPU)
¢ ¥Ry CPU & 9 g 91T 81 2 |
Tverg #gler gfe, ¥oreey (H1Y)

¢ TR b I T FHMT B QAR B
prfee e fafsa o aren W &1 9eT

.=

#giT gfre (CU)
¢ A TT 3AYS /A<STYE Iie b dra Rear
P AN BT Bl BT 2 |

zgher ghae (CU)

¢ HEYCR BT I8 9N ST O Faell TG HRal
2 qn Siftee Aol ofdr a1 o aA &1 B
BT 2|

TR aifor gfe (ALU)

¢ 9 & W@ Y T B
TRARE T FiforBe T YT, FH FIET
VT, §TYC,/ STICYT JIET BT/

¢ I HT R M IRE $9YC Scye faweH ©
S Hrgex ¥ faerme enll B

o7 (ROM) g %/

¢ R faveH # URIRT WS a1 YRR @1 T
ATt S 2

RAehiTT geca@rT o7 dave &
(MIPS : Million Instruction per second )
¢ FEYCR URRR & Falld X AT WIS Pl AU © |
a7 87 I7 M FCoT H
¢ T[T B & Iaid U &1 aredd §
Ffader #iRger s (Universal serial bus)

¢ TR P T wed de R |fde are A

FEl o & o Wiy 9 o g ol B
2

7TveIe
o & dieave RafRiT &1 aref 28—
Fieaec Raa grdg gorw 45 &
& TS gv Rae ovar &
P BT TANT PO THY ST U PR D
forg, amg I ST

F1

Ay & wRedifes Us @ifta gfve 7 8rar 2|
foreev

U&H T famd S &er & Iifved &l

RieFes &7 @ fou safdcerd Ied S+
PRl B |

Rreeq Foiie
¥ (RAM) sk Y@ (ROM) wewdt a9 @
R q=1 9 7 |

ST vaew 741 Silv YIS sl JAT
FHHISR W BT P ... gNIC DI Ol 2 |
v grga (Disk Drive) #
g dfew, i aeer fed @ 9t
HqEYUl UTe BRI &, HEAN 3 |
Rrecq gfae (System Unit)

) go~s feargd &1 9IS~ dle 9 b9 T
e st g |

MIDI port

FSF &1 Q=7 119 2
Free Software Foundation

HYeR Red & SR &\ al ¥ glg IR B oY

vagte @red (Expansion cards) @1 eFmn
IS

7evEIS gv g9 T wAed o

AGRAS & HHEICd © 4 Al fhad Aedd

I 29 BT 2|

gwor (Buses)

fearg < fafy faga smyfd gRReEa a=ar &
qoT srarS g Myl 98 8 WM R dRYeR

BT fagd Syl &= = |
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¢

¢

e (UPS: Uninterrupted Power Supply)

1981 § U] HFYeX & fAB™ &1 51 1 ¥
TFTE (IBM: International Business Machine)
ASThel U §rsd, #6d, IR fier safe &1
FEYSR | Siled & oy TANT 8 2 |

gews! 9ic (USB : Universal Serial Bus)

for @ § /root &I &
root e P 817 SRV &/

HFYER AR B W W USRIG 8F drell
afédel oge Sl Wb WA el (Blink)
&l B |

BHHY

qIH DA AT FEH SITET WART B dTell $19¢
farss g1

I 3V BIEIS
qSY 3R 2 dfel SeERT 2 |
qrERT fSagw &
MAW. BT gof B9 -
g7 e7g9 greas (One time Password)

A BT MABR fha 3R &e fHar or?
SF ST golerae 7 1964 ¥

ASE & 3 Wes dedl & 99 Reg & ar
g o e 2

0T & BT BV P T/

qSd &l s WigleT fSasd & w9 ¥ W
ST B A Bl 99 ASY Us W ST
2 O HFIER WA W Sl gAAT B, S $HET Il
=l

99 GIgcv
Jor 7 FORed T B UBRAH XA b fory
MICR T SYART o S7ar & foraa gof w9 7|

Magnetic Ink Character Recognition
Unix % mv GAFS &7 SYIRT a1 SI7am 2 |

mv B HT UGN BIgeT BT 719 §qci1 UG Bigel

¢

@ T SRRTLT § & oI @ ferd 14T o
g/

stedpiee & forT ... W &1 gAT fHar oer 2

T YR & AT o e 2
35 %9 (Web Cam)

ararst (Voice) STeT &I ol # uRafdd &x S9
fSollcd TRe A wUART &Rl & difd A
PGSR FHS AP Sl I AN Bl AGG BR Fhdll
g Sl ®Yex e & QBN $T WA @
IR FHA B |

W RarierT direage

Teh fSasd o R iR SRe <1 B b
BRAT & 3R b= B BMU B TIR B ST HART
¥ R Bl ¢ |

T

feargd & AH ¥ HFYEX W 9 WAl A
BRI

/e
fordad § aTAM SENGE! & gdildg 3R R

Bisad B e wxd & fau . HHS BT
IUANT AT & FeheT B |

Is-a

I8 fearsd s A 4 dRger IoR & A
PRFDHS AT 8 AR ST F dA U wR
REDE

3rcye feaigd

PBIF AT U I AR FD TN B AII—1T
Bisdl ¥ IURYT ST @ BEfeT & forw Suan
foram Srem 2

AUSlY IR HRIeR W 9l wrsfeT f¥arsa =
REZIRE
2oala] 7 e a7 @rsleT Rew
SYaTe &1 IMfashR fhas fhar o |
fFeinY wiew

DI A1 % JoR B SENag] dI YR axar
2l

81 SIRT @) ~(sign) A5 T Faf¥fa far

orar 8/

dire BT aeeye .. fasd W fe@mrr o 2 |
#rfiey a1 groiFey



	Page 1
	Page 2
	Page 3
	Page 4
	Page 5
	Page 6
	Page 7
	Page 8
	File 1.pdf
	Page 1
	Page 2
	Page 3
	Page 4
	Page 46
	Page 47
	Page 48
	Page 49
	Page 75
	Page 76
	Page 77
	Page 78

	File 2.pdf
	Page 10
	Page 11
	Page 12
	Page 13
	Page 47
	Page 48
	Page 49
	Page 50
	Page 67
	Page 68
	Page 69
	Page 70
	Page 80
	Page 81
	Page 82
	Page 83

	File 3.pdf
	Page 2
	Page 3
	Page 4
	Page 5
	Page 20
	Page 21
	Page 22
	Page 23
	Page 43
	Page 44
	Page 45
	Page 46
	Page 69
	Page 70
	Page 71
	Page 72

	50-53.pdf
	Page 50
	Page 51
	Page 52
	Page 53

	cover.pdf
	Page 1


